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Introduction to the ArcGIS 3D Analyst tutorial
IN THIS TUTORIAL

• Copying the tutorial data

• Exercise 1: Draping an image over a terrain surface

• Exercise 2: Visualizing contamination in an aquifer

• Exercise 3: Visualizing soil contamination and thyroid cancer rates

• Exercise 4: Building a TIN to represent terrain

• Exercise 5: Working with animations

• Exercise 6: ArcGlobe basics

• Exercise 7: ArcGlobe layer classification

• Exercise 8: Creating and using a terrain dataset

• Exercise 9: Creating a realistic 3D view

The best way to learn ESRI ArcGIS 3D Analyst is to use it. In the exercises in this tutorial, you will do the
following:

• Use ArcCatalog to find and preview 3D data.

• Add data to ArcScene.

• Set 3D properties for viewing data.

• Create new 3D feature data from 2D features and surfaces.

• Create new raster surface data from point data.

• Build a TIN surface from existing feature data.

• Make animations.

• Learn how to use ArcGlobe and manage its data content.

To use this tutorial, you need to have the 3D Analyst extension and ArcGIS installed and have the tutorial
data installed on a local or shared network drive on your system. Ask your system administrator for the
correct path to the tutorial data if you do not find it at the default installation path specified in the tutorial.

DATA CREDITS

Exercise 1: Death Valley image data courtesy of National Aeronautics and Space Administration (NASA)/Jet
Propulsion Laboratory (JPL)/Caltech.

Exercise 2: San Gabriel Basin data courtesy of the San Gabriel Basin Water Quality Authority.

Exercise 3: Belarus CS137 soil contamination and thyroid cancer data courtesy of the International
Sakharov Environmental University.

Exercise 4: Hidden River Cave data courtesy of the American Cave Conservation Association.
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Exercise 5: Elevation and image data courtesy of MassGIS, Commonwealth of Massachusetts Executive
Office of Environmental Affairs.

Exercise 6: Las Vegas Millennium Mosaic (Year 2000 Landsat) and QuickBird images data courtesy of
DigitalGlobe.

Exercise 7: Ozone concentration raster derived from data courtesy of the California Air Resources Board,
Southern California Millennium Mosaic (Year 2000 Landsat) image courtesy of DigitalGlobe, Angelus Oaks
imagery courtesy of AirPhoto USA, Southwestern U.S. elevation data derived from U.S. National Elevation
Data courtesy of the U.S. Geological Survey.

Exercise 8: Spot elevation points and breaklines are of the Napa River Watershed area. GIS data courtesy
of the County of Napa.

Exercise 9: Quickbird imagery of London courtesy of DigitalGlobe. Multipatch buildings Copyright © 2008
Google. All rights reserved.
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Copying the tutorial data
First, you will copy the tutorial data to a local drive. You will use ArcCatalog to browse to and copy the data.

Copying the tutorial data

Steps:

1. Start ArcCatalog by clicking Start > All Programs > ArcGIS > ArcCatalog 10.

ArcCatalog lets you find and manage your data. The left side of the ArcCatalog window is called
the Catalog Tree; it gives you a bird's-eye view of how your data is organized and provides a
hierarchical view of the geographic data in your folders. The right side of ArcCatalog displays the
contents of the selected branch of the Catalog tree.

2. Click in the Location combo box and type the path C:\arcgis\ArcTutor, which is where the
tutorial data is installed and press ENTER.

The ArcTutor folder is now the selected branch of the Catalog Tree. You can see its contents in
the Contents tab.

3. Right-click the 3DAnalyst folder and click Copy.

4. Click the Connect to Folder button, and choose the local drive where you want to place a copy
of the tutorial data to work from, then click OK.

5. Right-click the local drive you just made in your Folder Connections list and click Paste.
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The tutorial data folder is copied to your local drive. Now you'll make a folder connection to the
3DAnalyst folder in the Catalog Tree. A folder connection acts like a bookmark or mapped drive to
a path you frequently use.

6. Double-click the 3DAnalyst folder on your local drive and copy the path from the Location
combo box.

There should be nine exercise folders and one file geodatabase in your local drive.

7. Click the Connect to Folder button and paste the path, then click OK.

There is now a folder connection in the Catalog Tree for your local copy of the tutorial data.
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You can also disconnect the folder you do not need here. For example, right-click the folder
C:\arcgis\ArcTutor and click Disconnect Folder .

Now the folder is no longer available in the Catalog tree.
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Exercise 1: Draping an image over a terrain surface
Viewing a remotely sensed image draped over a terrain surface can often
lead to greater understanding of the patterns in the image and how they
relate to the shape of the earth's surface.

Imagine that you're a geologist studying Death Valley, California. You have
collected a TIN that shows the terrain and a satellite radar image that shows
the roughness of the land surface. The image is highly informative, but you
can add a dimension to your understanding by draping the image over the
terrain surface. Death Valley image data was supplied courtesy of NASA/
JPL/Caltech.

Turning on the 3D Analyst extension

First, you'll need to enable the 3D Analyst extension.

Steps:

1. Start ArcCatalog by clicking Start > All Programs > ArcGIS > ArcCatalog 10.

2. Click Customize and click Extensions.

3. Check 3D Analyst.

4. Click Close.

Complexity:
Beginner

Data Requirement:
Installed with software

Data Path:
See Copying the tutorial data

Goal:
Familiarize with the navigation tools to
preview data, and setting layer properties
to drape imagery.
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Previewing 3D data in ArcCatalog

Before you drape the image, you’ll browse to the terrain data and preview it in ArcCatalog.

Steps:

1. Navigate to the 3DAnalyst folder connection in the Catalog Tree.

2. Double-click 3DAnalyst.

3. Double-click Exercise1.

You see a folder called Data and a TIN layer called Death Valley Terrain.
A layer is a shortcut to geographic data. It also stores information about how the geographic data
should be drawn on a map or in a 3D view.

4. Click Death Valley Terrain.

5. Click the Preview tab. You can preview your GIS data in ArcCatalog. With 3D Analyst installed,
you can also preview some data in three dimensions.

6. Click the Preview drop-down arrow and click 3D View.

7. Right-click above the preview window and click 3D View Tools.
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The preview becomes a 3D preview, and a new set of tools appears on the 3D View Tools
toolbar.

The Navigate tool is active when you first preview data in 3D. You can see the names of tools by
hovering the pointer over the tool.

The Navigate tool allows you to rotate 3D data and change the apparent viewer height by clicking
and dragging left and right and up and down, respectively, in 3D preview.

8. Click inside the 3D preview and drag to the right.

The data rotates around its center. The Navigate tool also allows you to zoom in and out and pan
across the data, depending on the mouse button that you click while dragging in the 3D preview.
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9. Right-click the 3D preview and drag down.

The pointer changes to the Zoom In/Out pointer, and the view zooms in to the data.

10. Click the middle button—or both the right and left buttons if you have a two-button mouse—and
drag to the right.

The pointer changes to the Pan pointer, and the view pans across the data.

11. Click the Identify button and click on the TIN.

The Identify Results window that appears shows you the elevation, slope, and aspect of the
surface at the point you clicked.

12. Close the Identify Results window by clicking the top right x.
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13. Click the Full Extent button.

The view returns to the full extent of the data.

Now you’ve examined the surface data and begun to learn how to navigate in 3D. The next step is to start
ArcScene and add your radar image to a new scene.

Starting ArcScene and adding data

ArcScene is one of two 3D visualization environments for 3D Analyst (ArcGlobe is introduced in Exercises 5
and 6). Although you can preview 3D data in ArcCatalog, ArcScene allows you to build up complex scenes
with multiple sources of data.

Steps:

1. From ArcCatalog, click the ArcScene button on the 3D View Tools toolbar to launch the
application.
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2. In the ArcScene - Getting Started dialog box, click New Scenes and click the Browse button to
set the default geodatabase path to D:\3DAnalyst\3D_Default.gdb.

This location will be used for output spatial data generated in the tutorial exercises.

3. Click OK to close the Getting Started dialog box.

Note that many of the tools on the ArcScene Standard toolbar are the same as the 3D navigation
tools that you see in ArcCatalog.

4. Close ArcCatalog.

5. On the right side of the ArcScene window, move your pointer over the Catalog tab or click the
Catalog tab
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The Catalog window slides into the view, ready for use.

6. Navigate to the Exercise1 folder in the Folder Connections path where you locally saved the
tutorial data.

7. Click the Death Valley Terrain layer and drag it into the 3D view area of ArcScene, then release
the mouse button.

The TIN is drawn in the new scene, and the TIN layer is automatically added into the table of
contents.

8. Navigate to the Data folder inside Exercise1 from the Catalog window.
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9. Click the dvim3.TIF layer and drag it into the 3D view of ArcScene, then release the mouse
button.

The image is added to the scene.

The image is drawn on a plane, with a base elevation value of zero. You can see it above the
Death Valley terrain surface where the terrain is below 0 meters elevation (sea level); it is hidden
by the terrain surface everywhere else.

10. Uncheck the Death Valley Terrain layer.

Now you can see the whole image. The black areas are parts of the image that contain no data
and are a result of previous processing to fit the image to the terrain.
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You have added the image to the scene. Now you will change the properties of the image layer so that the
image will be draped over the terrain surface.

Draping the image

While the surface texture information shown in the image is a great source of information about the terrain,
some relationships between the surface texture and the shape of the terrain will be apparent when you
drape the image over the terrain surface. In ArcScene, you can drape a layer— containing a grid, image, or
2D features—over a surface (a grid or TIN) by assigning the base heights of the layer from the surface.

Steps:

1. Right-click dvim3.TIF in the ArcScene table of contents and click Properties.

The Layer Properties dialog box appears. You can change how a layer is drawn on a map or in a
scene by setting its properties.

2. Click the Base Heights tab.
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3. Click the option Floating on a custom surface.

Because the TIN is the only surface model in the scene, it appears in the surface drop-down list.

4. Click OK.

The image is draped over the terrain surface.

Now you will be able to navigate around the image and see the relationship between surface
texture, as shown by the image colors, and the shape of the terrain.
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Exploring the image

You will use the navigation tools on the ArcScene Tools toolbar to explore the draped image.

Steps:

1. Click the Zoom in button.

2. Click and drag a rectangle around the middle of the image.

The scene zooms to the middle part of the image.

3. Click the Navigate button.
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4. Click and hold the scene with the mouse pointer and slowly drag up and to the left.

The scene rotates, and the view angle lowers, so it looks as though you are looking down the
valley, past the higher land on the left side of the scene.

Draping the radar image over the terrain surface allows you to see the relationship between the
general shape of the land surface and the texture of the rocks and sediment that make up the
surface.
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Exaggerating the terrain

The valley is a broad area, relative to the height of the terrain, even though the mountains at the edge of the
scene are more than 2,000 meters above the valley floor. In order to enhance the sense of depth in the
scene, and to bring out subtle features in the terrain, you will exaggerate the height of the terrain.

Steps:

1. Right-click Scene layers in the table of contents and click Scene Properties.

The Scene Properties dialog box lets you set properties that are shared by all the layers in the
scene. These include the vertical exaggeration, the background color, the coordinate system and
extent of the data, and the way that the scene is illuminated (the position of the light source
relative to the surface).

2. Click the General tab.

3. Type 2 in the Vertical Exaggeration combo box.

4. Click OK.

The apparent height of the terrain is now doubled.

You can now clearly see how the alluvial fan spreads out onto the valley floor, between the larger
rocky area at the center of the scene and the smaller rocky area in the foreground at the left side
of the scene.
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You have added depth to the radar image, explored the general relationship between the data in the image
and the terrain data, and enhanced the scene so that you can perceive more subtle variations in the terrain.

Now that you’ve built the scene, you will save it so that you can explore it later if you choose.

Saving the scene

Scenes, also called Scene Documents, are like maps in that they contain information about how the layers
that are in the scene should be rendered and where the data is located.

Steps:

1. Click File and click Save As.

2. Navigate to the Exercise 1 folder.

3. Type Deathvalley as the file name.
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4. Click Save.

The scene will now be available for you to open later.
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Exercise 2: Visualizing contamination in an aquifer
Imagine that you work for a water district. The district is aware of some
areas where volatile organic compounds (VOCs) have leaked over the
years. Scientists from your department have mapped some plumes of VOCs
in the aquifer, and you want to create a 3D scene to help officials and the
public visualize the extent of the problem.

Some of the data has already been assembled in the Groundwater
ArcScene document. You will modify the scene to better communicate the
problem.

VOC data was supplied courtesy of the San Gabriel Basin Water Quality Authority.

Opening the Groundwater scene document

This scene document contains a TIN that shows the shape of the contaminant plume, a raster that shows
the concentration of the contaminant, and two shapefiles that show the locations of parcels and wells. You
will drape the concentration raster over the plume TIN, extrude the building features and change their color,
and extrude the well features so that the wells most endangered by the contamination may be more easily
recognized.

Steps:

1. Start ArcScene by clicking Start > All Programs > ArcGIS > ArcScene 10.

2. On the ArcScene - Getting Started dialog box, click Existing Scenes --> Browse for more.

The Open dialog box appears.

3. Navigate to the Exercise2 folder.

4. Click the Groundwater ArcScene document and click Open.

Complexity:
Beginner

Data Requirement:
Installed with software

Data Path:
See Copying the tutorial data

Goal:
Use ArcScene to assess the impact of a
groundwater contaminate in an aquifer
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The Groundwater scene opens. You can see that four layers are already added to the table of
contents.

Showing the volume and intensity of contamination

You’ll drape the raster of VOC concentration over the TIN of the contaminant plume surface to show the
volume and intensity of contamination in the aquifer.

Steps:

1. Right-click congrd in the table of contents and click Properties.

2. Click the Base Heights tab.

3. Click Floating on a custom surface and make sure the plume TIN is selected as the elevation
surface to provide height values.

Now you will change the symbology of the raster to show the intensity of the contamination.

4. Click the Symbology tab.

5. Click the Color Ramp drop-down arrow and click a red color ramp for the raster.
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6. Click OK.

7. Uncheck plume in the table of contents.

Now it is possible to see the shape of the plume and its intensity in 3D.

Showing the relationship of the plume to wells

You can see that some of the wells are within the area of the plume. However, it is difficult to see which
wells are most seriously affected because the contamination is more widespread but less concentrated at
greater depths.

You will extrude the well features based on their depth attribute in order to see which wells intersect the
plume.

Steps:

1. Right-click wells and click Properties.
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2. Click the Extrusion tab.

3. Check to enable Extrude features in layer and click the Calculate Extrusion Expression
button.

You will display the well points as vertical lines equal to the depth of the well. This information is
stored in the WELL_DPTH field.

4. Click WELL_DPTH.

5. Click OK.

6. Click the drop-down arrow to apply the extrusion expression by adding it to each feature’s base
height. The well depths are expressed as negative values, so they will be extruded downward.
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7. Click OK.

You can see the places where the wells intersect, or are close to, the plume. Now you will modify the scene
to show the priority of various facilities that have been targeted for cleanup.

Showing the facilities with a high cleanup priority

Analysts in your department have ranked the facilities according to the urgency of a cleanup at each
location. You’ll extrude the facilities into 3D columns and color code them to emphasize those with a higher
priority for cleanup.

Steps:

1. Right-click facility and click Properties.

2. Click the Extrusion tab.

3. Check Extrude features in layer and click the Calculate Extrusion Expression button.

4. Click PRIORITY1.
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5. Type *100.

6. Click OK.

The expression you created appears in the Extrusion value or expression box.

7. Click the Symbology tab.

8. Click Quantities.

9. Click the Value drop-down list and click PRIORITY1.
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10. Click OK to close the Layer Properties dialog box and apply the extrusion and symbology
settings.

The facilities are now extruded in proportion to their priority score. The scene now shows the
shape and intensity of the contamination, the wells in relationship to the plume, and the facilities
that need to be cleaned up in order to prevent further pollution of the groundwater.

Now you’ll save your changes to the scene.

11. Click the Save button.
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Exercise 3: Visualizing soil contamination and thyroid
cancer rates
In 1986, after the catastrophic accident at the Chernobyl nuclear power plant
in Ukraine, a large amount of radioactive dust fell on Belarus. Since then,
scientists have studied the aftermath of the accident. One tool for exploring
the data is 3D visualization. In this exercise, you will create two surfaces
from point data collected in Belarus. One set of points contains
measurements of soil CS137 concentrations. CS137 is one of several
radioactive isotopes released by the accident. The other set of points shows
the rates of thyroid cancer, aggregated by district, with the sample point
placed near the district centers.

The CS137 contamination and thyroid cancer data was supplied courtesy of the International Sakharov
Environmental University.

Viewing the point data

First, you will open the Chernobyl scene and view the point data.

Steps:

1. Start ArcScene by clicking Start > All Programs > ArcGIS > ArcScene 10.

2. On the ArcScene - Getting Started dialog box, click Existing Scenes --> Browse for more.

If you already have ArcScene open from the previous exercise, simply click File and click Open.

3. Navigate to Exercise3 and click the Chernobyl ArcScene document.

4. Click Open.

Complexity:
Beginner

Data Requirement:
Installed with software

Data Path:
See Copying the tutorial data

Goal:
Use ArcScene and geoprocessing tools
to compare two surface created from
point data

3D Analyst Tutorial

Copyright © 1995-2010 Esri. All rights reserved. 30



The CS137 soil measurements are shown with small point symbols, using a graduated color
ramp to show the intensity of the contamination. The districts’ thyroid cancer rates are shown
with larger symbols, using a different color ramp.

Creating 3D point features

The soil CS137 samples are 2D points with some attributes. One way to view 2D points in 3D is by setting
an extrusion expression, or a base height. You can also incorporate a z-value into a feature's geometry to
allow it to be directly viewed in 3D without the need to set a base height from a surface or an attribute.

This exercise requires the use of 3D Analyst geoprocessing tools, so make sure the 3D Analyst extension is
enabled so that you can access the full suite of tools available. You will use the Search window to quickly
search for individual tools by their name or by function keyword.

Steps:

1. On the right side of the ArcScene window, move your pointer over the Search tab or click the
Search tab to bring it into view.

2. Click Tools to set the search filter on the Search window.

3. Click inside the Search combo box and type feature to 3d by attribute and press
ENTER or click the Search tool.

The search will return exact and relative keywords of tools. The hammer symbol left of the search
results also indicates the item is a tool.

Using the tool search results, now you will create 3D point features from the soil CS137 points.

4. Click Feature To 3D By Attribute from the search results.

5. In the tool dialog box, click the Input Features drop-down list and click
Subsample_1994_CS137.
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6. Click Browse and set the Output Feature Class location to the 3D_Default geodatabase for the
3D Analyst tutorial data. Then type the output feature name to CS137_3D.

7. Click the Height Field drop-down list and click CS137_CI_K

8. Click OK.

You'll see a progress bar at the bottom of your document displaying the name of the currently
executing tool. When the tool finishes executing, a pop-up notification will appear on the system
tray. This is called background geoprocessing, which, by default, is turned on when the software
is installed and opened. To disable background geoprocessing, use the Geoprocessing Options
dialog box from the Geoprocessing main menu in ArcScene.

The features are converted to 3D point features; however, they still seem to be resting on a flat plane,
because the CS137 concentration values range from 0 to 208.68, which is small relative to the horizontal
extent of the data.

Increasing the vertical exaggeration

You will exaggerate the scene to show the new points with their height embedded in the feature geometry.

Steps:

1. Click View and click Scene Properties.

2. Click the General tab.

3. Click Calculate From Extent.

3D Analyst Tutorial

Copyright © 1995-2010 Esri. All rights reserved. 32



4. Click OK.

5. Click the Full Extent button.

Now that you can see the new 3D points in the scene, you can turn off the original CS137 sample
point layer.

6. Uncheck the box in the table of contents beside Subsample_1994_CS137 and click the minus
sign beside the box to hide the classification.

Extruding columns

Viewing points in 3D space is one way to investigate data. Another way is to extrude points into columns.
You will extrude the thyroid cancer points into columns to compare them to the contamination data.

Steps:

1. Right-click ThyroidCancerRates and click Properties.
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2. Click the Extrusion tab.

3. Check to enable Extrude features in layer and click the Calculate Extrusion Expression
button.

4. Click INCID1000 (the rate of cases per 1,000 persons).

Because the z-values of the phenomena that you are comparing have different ranges, you will
multiply the cancer rate by 100 to bring the values into a range similar to that of the CS137
measurements.

5. Type *100.

6. Click OK on the Expression Builder dialog box.
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7. Click OK on the Layer Properties dialog box.

Now the district centroid points are shown with columns proportionate to the thyroid cancer rates.
If you navigate the scene, you will see that the areas with the highest contamination levels also
tend to have high thyroid cancer rates, although there are areas with lower CS137 contamination
levels that also have high cancer rates.

Creating a surface from point sample data

You know what the soil concentrations of CS137 are at the sample point locations, but you do not know
what they are at the locations between sample points. One way to derive the information for locations
between sample points is to interpolate a raster surface from the point data. There are many ways to
interpolate such surfaces, which result in different models of varying accuracy. In this exercise, you will
interpolate a surface from the samples using the Inverse Distance Weighted (IDW) interpolation technique.
IDW interpolation calculates a value for each cell in the output raster from the values of the data points, with
closer points given more influence and distant points less influence.

Steps:

1. Click the Catalog tab to expand the Catalog window.

2. Scroll to find Toolboxes.

This is another way of finding tools as an alternative to using the Search window. The Catalog
window also maintains all the toolboxes.

3. Expand Toolboxes, click System Toolboxes, then expand the 3D Analyst Tools toolbox.

4. Navigate to the Raster Interpolation toolset and double-click the IDW geoprocessing tool that
appears in the lower window.

5. Click the Input point features drop-down list and click Subsample_1994_CS137.

6. Click the Z value field drop-down list and click CS137_CI_K.
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7. Verify that the Output raster location is set to the default geodatabase (3D_Default.gdb),then
change the output raster name to CS137_IDW.

Otherwise, click the Browse button to set the output raster location and click Save.

8. Click inside the Output cell size box and increase the value to 5000.

9. Click OK.
ArcScene interpolates the surface and adds it to the scene.

Viewing the interpolated surface

Now that the surface has been added to the scene, you can see that there are two areas with very high
concentrations of CS137. You will view the surface in perspective, with a new color ramp, to better see its
shape.

Steps:

1. Right-click CS137_IDW and click Properties.
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2. Click the Symbology tab and select Stretched from the Show category.

3. Click the Color Ramp drop-down arrow and click a new color ramp.

4. Click the Base Heights tab.

5. Click Floating on a custom surface.

Confirm that the IDW surface is listed as the custom surface.
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6. Click OK.

7. Uncheck CS137_3D in the table of contents.

Now you can see the interpolated surface of CS137 contamination, along with the thyroid cancer rate data.
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Next, you will select the province centers with the highest rates of thyroid cancer.

Selecting features by an attribute

Sometimes it is important to focus on a specific set of data or specific features. You can select features in a
scene by their location, by their attributes, or by clicking them with the Select Features tool. You will select
the province centers by attribute to find the locations with the highest rates.

Steps:

1. Click Selection and click Select By Attributes.

2. Click the Layer drop-down arrow and click ThyroidCancerRates.

3. Double-click INCID1000 in the fields list.
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4. Click the >= button.

5. Type 0.5.

6. Click Verify to check the selection expression you have built.

7. Click Apply.

8. Click Close.

The province centers with thyroid cancer rates greater than 0.5 cases per 1,000 are now selected
in the scene. They are drawn in light blue to indicate that they are selected.

Viewing the attributes of features

You will investigate attributes of the selected locations and find out how many cases of thyroid cancer
occurred in these districts.
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Steps:

1. Right-click ThyroidCancerRates and click Open Attribute Table.

The Table window of the layer's attributes appears in the view.

2. Click the title bar of the Table window and drag it from its current location toward the center of
the 3D view.

The guide diamond appears pointing towards the four edges of the 3D view where you can
optionally dock the Table window.

3. Move the pointer toward the bottom guide arrow until it darkens to indicate the selected docking
location.

A shaded outline of the window appears in the designated area.
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4. Release the mouse button to dock the Table window in the bottom of 3D view space.

You can play with other arrow location on the guide diamond to see which location suits your
preferences. For this exercise, we will continue having the Table window docked at the bottom of
the view.

5. In the Table window, click the Selected button.
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The table now shows only those features that you selected.

6. Right-click CASES and click Sort Ascending.

The selected province centers are sorted according to the number of cases.

7. Right-click CASES and click Statistics.
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The total number of cases in the selected set of 11 province centers is 176.

8. Close the Selection Statistics dialog box.

9. Click the Navigate button and click on the scene.
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You can work in ArcScene while the Attribute Table is open.

10. Click the Save button.

In this exercise, you have created 3D features, extruded point features, and interpolated a raster surface from
a set of data points. You’ve compared the extruded vector data to the surface data and explored the attributes
of the vector data.
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Exercise 4: Building a TIN to represent terrain
The town of Horse Cave, Kentucky, is situated above a cave that once
served as the source of drinking water and hydroelectric power for the town.
Unfortunately, the groundwater that flows in the cave was polluted by
household and industrial waste dumped on the surface and washed into
sinkholes. Dye-tracing studies and a three-dimensional survey of the cave
revealed the relationship between the cave passages and the town and
demonstrated the connection between open surface dump sites and
contamination of the groundwater in the cave below.

Thanks to the development in 1989 of a new regional sewage facility and the joint efforts of the Cave
Research Foundation and the American Cave Conservation Association (ACCA), the groundwater is cleaner,
and the cave has been restored. It is now operated as a tour cave and educational site by the ACCA.

Cave data was provided courtesy of the ACCA.

Viewing the cave and the landscape

First, you will open the BuildTIN scene and view the cave survey and some terrain data layers. You’ll use
this terrain data to create a TIN and drape some other layers on it to visualize the relationship of the cave to
the town.

Steps:

1. Start ArcScene by clicking Start > All Programs > ArcGIS > ArcScene 10.

2. On the ArcScene - Getting Started dialog box, click Existing Scenes --> Browse for more.

If you already have ArcScene open from the previous exercise, simply click File and click Open.

The Open dialog box appears.

3. Navigate to the Exercise4 folder and double-click the BuildTIN ArcScene document.

The scene opens, and you can see the location of roads and railroads, some sample elevation
points, and a few significant contour lines. In the table of contents, you can see that some layers
have been turned off.

4. Check the box to show the Cavesurvey layer.

Complexity:
Beginner

Data Requirement:
Installed with software

Data Path:
See Copying the tutorial data

Goal:
Use ArcScene and ArcMap to construct a
TIN surface model, and geoprocessing
tools to conduct surface analysis
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5. Right-click Cavesurvey and click Zoom To Layer.

The cave survey data consists of PolylineZ features, which are automatically drawn in 3D
because they have z-values embedded in their geometry. They appear above the rest of the data
because all the other layers are drawn with the default elevation of 0.

In the next steps, you will build a TIN using geoprocessing tools to provide the base heights for
the streets and a photo of the town.

Creating a TIN from point data

You have a point layer called vipoints point. This coverage consists of points with an attribute called SPOT
that contains elevation values taken at these points. You’ll create the TIN surface model from these points
using the Create TIN geoprocessing tool.

When using geoprocessing tools, you will see a progress bar at the bottom of your document displaying the
name of the currently executing tool. When the tool finishes executing, a pop-up notification will appear on
the system tray. This is called background geoprocessing which, by default, is turned on when the software
is installed and opened. To disable background geoprocessing, use the Geoprocessing Options dialog
box from the Geoprocessing main menu.

Steps:

1. Click the Catalog tab to expand the Catalog window into the view.

2. Scroll to find Toolboxes.

3. Expand Toolboxes, click System Toolboxes, then choose the 3D Analyst Tools toolbox.
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4. Navigate to the TIN Management toolset and double-click the Create TIN geoprocessing tool.

5. Click the Browse button to set the Output TIN location.

6. Click the Home button, double-click the Terraindata folder, then change the output TIN name to
tin1 and click Save.

Confirm that the Output TIN location is set to the Home - Exercise4 folder.

7. Click the Input Feature Class drop-down list and click vipoints point.
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The SPOT field name appears in the height_field column, and the layer will be triangulated as
mass points.

8. Click OK.

The TIN is created and added to the scene. Note that it is drawn above the Cavesurvey layer; the
elevation values in the TIN define its base height.

By default, the TIN is symbolized using a single color for every face.

9. Right-click the tin1 layer in the table of contents and click Properties.

10. Click the Symbology tab.
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You can see there is a single renderer in place, titled Faces.

11. Click the Add button to open up the Add Renderer dialog box.

12. Click the Face Elevation with graduated color ramp option and click Add.

13. Click Dismiss to close the Add Renderer dialog box and return to the Layer Properties dialog
box.
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If the symbol for the highest elevation range is set to blue instead of white, then right-click on any
of the symbols and click Flip Symbols.

This will switch the order of the symbols and render the highest points of the TIN as snow-capped
peaks.

14. Switch off the original single color renderer by unchecking the Faces checkbox in the list of
renderers.

15. Click OK to close the Layer Properties dialog box.

While this TIN is a fairly good model of the surface, you can make it more accurate by adding
more features.

Adding features to a TIN

Now you will add hard and soft breaklines and a clip polygon to the TIN. You’ll add the railroad features as
soft breaklines, so they’ll be represented on the surface but won’t influence the shape of the surface. You’ll
add the brklines features as hard breaklines with elevation values to refine the shape of the surface in areas
that you’re most interested in. Finally, you will add the smclp polygon as a soft clip polygon to more
smoothly define the edge of the TIN.

Steps:

1. From the Catalog window, scroll to find Toolboxes.

2. Expand Toolboxes, click System Toolboxes, then click the 3D Analyst Tools toolbox.

3. Navigate to the TIN Management toolset and double-click the Edit TIN geoprocessing tool from
the bottom window.
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4. Click the Input TIN drop-down list and click tin1.

5. Click the Input Feature Class drop-down list and click railroad.

6. Click the height_field drop-down arrow and click <None>.
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7. Click the SF_type drop-down arrow and click softline.

8. Click the Input Feature Class drop-down list and click brklines.
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The Edit TIN tool detects that there is an ELEVATION field and uses it for the height source. You
will accept the default and triangulate them as hard breaklines.

9. Click the Input Feature Class drop-down list and click smclp.

10. Click the height_field drop-down arrow and click <None>.
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You have defined the feature layers that you want to add to your TIN and specified how they
should be integrated into the triangulation.

11. Click OK.

The new features are added to the TIN.

After the next step, you will see that the railroad follows a bed that has been leveled somewhat relative to
the surface.

Setting feature base heights from the TIN

Now you will set the base heights for the road and railroad features from the new TIN.

Steps:

1. Right-click roads and click Properties.

2. Click the Base Heights tab.

3. Click Floating on a custom surface.

4. Click the drop-down arrow and click tin1.
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5. Click OK.

The road features are now draped over the TIN surface that you created. Now you will drape the
railroad features over the surface.

6. Right-click railroad and click Properties.

7. From the Base Heights tab, click Floating on a custom surface.

The elevation surface is already set to tin1.

8. Click OK.

The railroad features are now draped over the TIN surface that you created.
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Next you’ll drape the aerial photo over the TIN.

Setting raster base heights from the TIN

Including the aerial photo of the town in the scene makes the relationship between the cave and the town
much more evident. You’ll drape the raster over the TIN and make it partly transparent so that you’ll be able
to see the cave beneath the surface.

Steps:

1. Right-click photo.tif and click Properties.

2. Click the Base Heights tab.

3. Click Floating on a custom surface.

4. Click the drop-down arrow and click tin1.
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5. Click the Display tab.

6. Type 30 in the Transparency text box.

7. Click OK.

8. Check photo.tif in the table of contents so it becomes visible in the scene.

Now the aerial photo is 30 percent transparent. You can see large patches of the TIN over the photo
because the TIN and the photo have the same drawing priority. If you wanted the TIN to be visible below the
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photo, you could change its drawing priority to 10 (lowest) on the Rendering tab of the TIN's Layer
Properties dialog box. You could also offset the base height of the TIN or the photo by a small amount.

Cleaning up the scene

To clean up the scene, you'll turn off the visibility of some layers that are no longer needed and make the
cave line symbol larger.

Steps:

In the table of contents, do the following:

1. Uncheck vipoints point.

2. Uncheck brklines.

3. Uncheck tin1.

4. Click the line symbol for the Cavesurvey layer.

5. Type 5 in the Width box.
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6. Click OK.

Now you can see the three-dimensional passages of the cave, symbolized by thick lines. The
surface features and the aerial photo provide context, so you can easily see the relationship of the
cave to the town as you navigate the scene.
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Creating a profile of the terrain

The cave follows the valley floor orientation. To get an understanding of the shape of the valley, you will
create a profile across the TIN. To create a profile, you must first have a 3D line (feature or graphic). You
will start ArcMap, add the TIN to the map, and digitize a line to make your profile.

Steps:

1. Start ArcMap by clicking Start > All Programs > ArcGIS > ArcMap 10.

2. On the ArcMap - Getting Started dialog box, select New Maps and then click Browse to set the
default geodatabase path to D:\3DAnalyst\3D_Default.gdb.

This location will be used to store output spatial data generated in the tutorial exercises.

3. Click OK to close the Getting Started dialog box.

ArcMap finishes opening.
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Now you will add the 3D Analyst toolbar to ArcMap. The ArcMap 3D Analyst toolbar contains
many tools that do not appear on the ArcScene 3D Analyst toolbar. Two of these are the
Interpolate Line tool and the Create Profile Graph tool, which you will use to create your profile
of the surface.

4. Click Customize, point to Toolbars, and click 3D Analyst.

The 3D Analyst toolbar appears.

5. Click Customize and click Extensions.

6. Check 3D Analyst if it's not already.
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7. Click Close.

The 3D Analyst extension is enabled.

8. Open the Catalog window and navigate to the Exercise4\Terraindata folder in the Folder
Connections path where you locally saved the tutorial data.

9. Click the tin1 layer and drag it into the map view, then release the mouse button.
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If prompted, click OK to close Unknown Spatial Reference warning message box.

The TIN is drawn in the new scene, and the TIN layer is automatically added into the table of
contents.

10. From the 3D Analyst toolbar, click the Interpolate Line button.

11. Click the upper-left corner of the TIN, drag the line to the lower-right corner, and double-click to
stop digitizing.
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You can create a profile along a line with more than one segment, but in this case you’ll just make
one straight line.

12. Click the Profile Graph Tool button.

The profile graph is created.

You can edit the title, subtitle, and other properties of the graph; save, print, or export the graph;
copy it to the clipboard; and show the graph on the layout. You can also simply close the graph.

13. Right-click the Profile Graph Title bar and click Add to Layout.

The view automatically switches to Layout View. You can see the different view icons change in
the bottom of the display.
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14. Close the Profile Graph window.

You can see the graph on the layout of the map.

15. Click the Data View button to return to data view.

Creating a line of sight on the terrain

Another way of understanding the terrain is to create a line of sight. Lines of sight show what parts of a
surface are visible and what parts are hidden along a line from an observer's point to a target point.

Steps:

1. Click the Create Line of Sight button.
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2. Type 2 in the Observer offset text box.

The line of sight will be calculated to show what is visible from the perspective of an observer two
meters tall, as the z-units for this scene are meters.

3. Click on the south slope of the higher land in the upper right part of the TIN (the observer point),
drag the line to the lower-right part, and release the mouse button (the target point).

The line of sight is calculated. The green segments show areas that are visible from the observer
point; the red segments are hidden from the observer.

4. Close the Line Of Sight dialog box.

Lines of sight, like other graphic lines, can be copied from ArcMap to ArcScene. Now you will copy
both the lines you've created into the scene.

5. Click Edit and click Select All Elements.
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Both of the lines you created are selected.

6. Click Edit and click Copy.

7. Switch back to ArcScene and click Edit, then click Paste.

The lines are pasted into the scene.
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If necessary, to deselect the pasted lines, click away from the lines somewhere else in the scene
to unhighlight them.

8. Click the Save button in ArcScene.

9. Click File in ArcMap and click Exit.

10. Click No to saving changes and close ArcMap.

In this exercise, you learned how to create and work with a TIN surface model using ArcScene and ArcMap.
You discovered how to construct and symbolize a TIN dataset to accurately represent a 3D surface.
Breaklines and polygons were added to additionally depict surface features, such as railroads and terrain
elevation values. Further surface analysis was then conducted using aerial photography as a draped raster
layer on the TIN. Finally, you completed the exercise conducting 3D surface analysis on the TIN model using
the interpolate line and create profile graph tools in ArcMap.

Now that you've learned how to represent a surface using a TIN model, you can begin to explore other areas
of the ArcGIS 3D Analyst extension. In the next exercise, you will learn how to create and work with
animations in ArcGlobe.
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Exercise 5: Working with animations
Imagine that you wish to create an animated sequence showing the flight of
an object over a landscape. You've created a TIN and have draped images
over it to show the area. You also have some data pertaining to a strange
phenomenon that has been occurring in the region. You are interested in
displaying all the data in a dynamic way, making an animation to tour points
of interest, and showing how you made the surface. You would also like to
model the phenomenon by moving a layer in the scene.

The tutorial data has already been assembled in the scene document named Animation.sxd. You will use
animation tools in ArcScene to effectively convey the points you want to show.

Data was supplied courtesy of MassGIS, Commonwealth of Massachusetts Executive Office of Environmental
Affairs.

In this exercise, you will play an existing animation in an ArcScene document, Final Animation_A.sxd, and
perform the tasks typically used to create the animation. Note that the majority of steps you'll perform in
ArcScene to create the animation are also applicable in ArcGlobe.

Opening the Final Animation_A scene document

In this section, you'll play an animation that demonstrates some effects you can create when you animate a
scene.

Steps:

1. Start ArcScene by clicking Start > All Programs > ArcGIS > ArcScene 10.

2. On the ArcScene - Getting Started dialog box, click Existing Scenes --> Browse for more.

The Open dialog box appears.

3. Navigate to the Exercise5 folder and double-click Final Animation_A ArcScene document.

This scene contains geographic information and recorded special effects that have been
combined to make an animation.

Complexity:
Beginner

Data Requirement:
Installed with software

Data Path:
See Copying the tutorial data

Goal:
Create, save and customize the effects of
an animation of your 3D view
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Playing the scene’s animation

To view a scene's animation, you need to have the Animation toolbar accessible in the view.

Steps:

1. Click Customize, point to Toolbars, and click Animation.

The Animation toolbar appears. Now you'll play the animation.

2. Click the Open Animation Controls button.

This animation shows the flight of a hypothetical unidentified flying object (UFO) over the terrain.

3. Click the Play button.

The animation plays, illustrating some of the effects you can use in an animated scene.
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Now you will work through the steps used to make animations like this one.

Opening the Animation scene document

Steps:

1. In ArcScene, click File and click Open.

2. Navigate to the Exercise5 folder and double-click Animation ArcScene document.

The scene contains an orthophoto, a scanned topographic map, and other data you need to make
your animation.
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In this section, you'll use the animation tools to capture keyframes, import tracks, play back your animations,
and save them to a scene document.

You will use three types of keyframes to capture building your animation. The first is a camera keyframe. A
camera keyframe is a snapshot of the view you see in a scene. The second, a layer keyframe, is a snapshot
of a layer's properties. The third type is a scene keyframe, which stores properties of a scene. In this
section, you will create a simple animation from a set of camera keyframes.

Capturing perspective views as keyframes to make an animation

The simplest way to make animations is by capturing views to be stored as keyframes. The captured views
are snapshots of camera perspectives in a scene at a particular time. The most fundamental element of an
animation is a keyframe. Keyframes are used as snapshots to interpolate in between a track. You'll create a
series of keyframes to make a camera track that will show an animation between points of interest in your
study area.

Steps:

1. Click the Capture View button to create a camera keyframe showing the full extent of the scene.

For a camera keyframe, the object is the virtual camera through which you view the scene.
Navigating the scene changes camera properties that determine its position.

ArcScene interpolates a camera path between keyframes, so you'll need to capture more views to
make a track that shows animation.

2. Right-click UFO.lyr and click Zoom To Layer.
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3. Click the Capture View button to create a camera keyframe showing the UFO layer.

4. Click the Full Extent button to view all the data.

5. Click Zoom In on the Tools toolbar and zoom to Goss Heights, located near the center of your
view.

6. Click the Capture View button to create a camera keyframe of Goss Heights.

7. Click the Full Extent button.

8. Zoom to Littleville Lake using the Zoom In tool again.
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9. Click the Capture View button to capture a view of Littleville Lake.

10. Click the Full Extent button.

The captured views you just made are stored as a set of camera keyframes in a camera track. When the
track is played, it shows a smooth animation between the keyframes. Next, you'll play your animation track.

Playing back your animation

You will play back animations using simple tools that resemble the controls of a movie player.

Steps:

1. Click the Open Animation Controls button.

2. Click and hold the top bar of the Animation toolbar and drag it to the upper-right corner of the
scene so it won't block your view of the tools or data.
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3. Click the Play button.

An animation is played back by interpolating the camera position between the keyframes in the
track. In this case, the animation shows a virtual tour through the views you captured.

Clearing an animation

If you want to start over, you can erase all the tracks you created. In this section, you'll remove the tracks
you just created so you can improve your animation.

Steps:

1. Click Animation and click Clear Animation.

All animation tracks are removed from the scene.

Recording navigation

Another way to create a camera track for an animation is to record in real time while you navigate in a
scene. In this section, you will record your view of the scene while you navigate using the Fly tool.
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Steps:

1. Click the Fly tool.

The Fly tool allows you to fly through your scenes.

2. Click the Record button to start recording your navigation.

ArcScene begins recording as soon as you click the Record button. If you don't navigate right
away, your track will reflect this.

You will know you are recording because the button changes from black to red.

3. Click once in the center of the scene to activate the Fly tool. You start flying by entering into
hovering mode.

In this mode, your viewpoint follows the cursor. Point in the direction you wish to look.

4. Click once more to begin flying through the scene.

Point in the direction you want to move. Click again to increase your speed and right-click to
decrease your speed. Your speed is indicated in the status bar in the lower-left corner of the
ArcScene window.
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5. Press ESC to stop flying.

You can also stop flying by clicking the middle button or wheel on the mouse (if you have one) or
right-clicking until your speed is zero.

6. Click the Stop button to finish recording.

You have recorded your flight path through the scene as a new camera track that began when
you clicked the Record button and ended when you clicked the Stop button.

7. Click the Full Extent button.

8. Click the Play button to see the animation you recorded.

When you are done viewing the animation you recorded, clear the track so you can make a better
one in the next section.

9. Click Animation and click Clear Animation.

3D Analyst Tutorial

Copyright © 1995-2010 Esri. All rights reserved. 78



Making a camera track from 3D bookmarks

In the previous sections, you navigated in a scene and created keyframes to build a camera track. Another
way to create the keyframes for a camera track is to import bookmarked perspective views of a scene. In
this section, you'll create keyframes from 3D bookmarks.

Steps:

1. Click Animation and click Create Keyframe.

2. Click the Type drop-down arrow and choose Camera.

3. Click New to create a new track.

4. Click Create.
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You've now created a camera track with one camera keyframe showing the full extent of your
scene. You'll need to add more keyframes to your track so that it will show animation. Now, you'll
import bookmarks to create the keyframes for the rest of the animation.

5. Check Import from bookmark.

6. Click the Import from bookmark drop-down arrow and click Goss Heights.

7. Click Create to make the second keyframe in your track.

8. Click the Import from bookmark drop-down arrow and choose LittleVilleDam.

9. Click Create to import this bookmark as a keyframe.

10. Click the Import from bookmark drop-down arrow and click Knightville.

11. Click Create to make the Knightville keyframe.

12. Click the Import from bookmark drop-down arrow once more and click Overview.

13. Click Create to import a keyframe showing all the data.
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14. Click Close.

15. Click the Play button.

The camera track plays, moving the camera through the set of keyframes you imported from
existing 3D bookmarks.

Switching the visibility between layers using a group animation

Now that you have explored some of the ways to create an animated camera track from keyframes, you’ll
learn how to change the way layers in a scene are displayed during animation. In this section, you will
switch the layer that is draped over the terrain model to show different ways of representing the terrain.

Steps:

1. Click Animation and click Create Group Animation.

2. Select the group layer named Image Data.

3. Slide the Fading transition bar about a quarter of the way to the right.

4. Check Blend layers when fading.

5. Click OK.
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The Layer track you just created toggles the visibility of successive layers to animate a
progression between them. The transition settings you modified will show a smooth blending
between the layers in the progression.

6. Click the Play button to watch your animation.

If you see a wireframe display, it is because ArcScene will switch to wireframe if a layer renders
too slowly. Once the layers are rendered, the wireframe will go away.

Since you didn't clear the animation track you made from the keyframes, it plays in addition to the
layer tracks you just created; however, you can stop the camera track from playing. You'll do this
next.

Using the Animation Manager to disable a track from playing

The Animation Manager allows you to control many properties of an animation. In this section, you'll use
the Animation Manager to stop a camera track from playing.

Steps:

1. Click Animation and click Animation Manager.
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2. Click the Tracks tab.

3. Uncheck Camera track 1.

4. Click Close.

You have disabled the camera track. Now it will not play as part of the animation.

5. Click the Play button.

The animation plays again, only showing the layer tracks this time. It may now seem that the
duration of the animation is too long. You can control the amount of time in which an animation is
played.

Using Animation Controls to adjust the playback duration

Steps:

1. Click Options.

2. Type 10 in the By duration text box.

3. Click Options again to close this portion of the dialog box.
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4. Click the Play button.

The animation now plays more quickly.

Moving an object along a predefined path

One of the things an animation allows you to do is move an object through a scene. You can add a layer
containing a model vehicle and move it through the scene along a specified track. Note that this functionality
is only available in ArcScene.

You can choose to move a layer along a selected line feature or graphic. The scene contains a graphic layer
with a model UFO that was created using Visual Basic code. In the next set of steps, you'll fly the model
UFO along a shapefile that shows its flight path.

Steps:

1. Turn on the Flight Path layer in the table of contents by checking it.

2. Right-click Flight Path, point to Selection, then click Select All.
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Tip: • You can also use the Select Features tool to select the path
you want to use if it is constructed from a single selected line
feature. Use the Select Graphics tool if your path is
constructed from a line graphic.

3. Click Animation and click Move Layer along Path.

4. Click the Layer drop-down arrow and click UFO.lyr.
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5. Type a Vertical offset of 75. This will make the object appear to fly above the surface.

ArcScene can improve the simulation of the flight of an object, such as an airplane, along a path
by making the object point in the direction it is moving and by rolling it from side to side as if it
were banking. In the next steps, you’ll define a roll for the UFO layer.

6. Click Orientation Settings to modify the layer's position while it's animated.

7. Click Calculate from path to calculate the layer's roll based on the path's shape.

8. Type 1 as a scale factor.

9. Click OK.
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10. Click Import to import the selected line as a flight path.

The UFO layer moves along the selected path. The movement is stored as a set of layer
keyframes in a layer animation track. Now you'll disable the tracks you created previously so that
just the UFO track is played.

11. Click Animation and click Animation Manager.

12. Click the Tracks tab.
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13. Uncheck Group animation (Mesh).

14. Uncheck Group animation (Photo.sid).

15. Uncheck Group animation (Topo.sid).

16. Click Close.

17. Uncheck Flight Path to turn off the visibility of this layer.

18. Click the Play button.

The UFO flies along the path you indicated. Next, you'll move the camera along a predefined path.

Creating a camera flyby from a path

You can move a camera along a flight path in the same way you just moved a layer along a path. Next,
you'll combine the track you made in the last step with one that will point the camera at the UFO as it flies.

Steps:

1. Check Flight Path, make sure the line you chose for your path is still selected, then uncheck
Flight Path.
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You'll move the camera location to a predefined location in the center of the scene that will give
you a better vantage point from which to view the UFO layer as it is moved.

2. Click Bookmarks, then click UFO.

3. Click Animation and click Create Flyby from Path.

4. Click the third path destination option.

This option lets you observe the UFO as it moves along the path.
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5. Click Import.

6. Click the Play button.

Both tracks play. The UFO layer moves, and the camera follows its movements.

7. Uncheck the Topo.sid check box to make the orthophoto visible.

The animation is playing too quickly. Next, you'll learn how to adjust the duration that the
animation is playing to enhance the visual effect.

8. Click Options.
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9. Type 30 in the Duration text box.

10. Click Options to minimize the dialog box.

11. Click the Play button.

Now the animation plays more slowly as the UFO flies over the terrain.

Saving an animation in a scene document

You can save animation tracks in a scene document. In the next step, you'll save the animation you made in
a scene document.

Steps:

1. Click File and click Save As.

2. In the File name text box, type Animation_A.
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3. Click Save.

The new scene document is created, storing the animation tracks.

4. Click File in ArcScene and click Exit.

In this exercise, you learned how to create and save simple animations that help you better visualize 3D data.
This exercise focused on creating animations in ArcScene, but the majority of steps can also be performed in
ArcGlobe.

Note that the Animation toolbar is also available in ArcMap, meaning that animations can also be created in
this application. A 3D Analyst license is not required to animate data in ArcMap. You can capture the view to
create a map view track (the ArcMap equivalent of a camera track in ArcScene or ArcGlobe) that captures the
display extent. This allows you to create an animation where you are zooming in and out and panning the
display. You can also create a map layer track (the ArcMap equivalent to the layer track in ArcScene or
ArcGlobe) to create an animation where you are altering layer visibility or transparency.

As you can see from this exercise, depending on the type of animation you want to create there are different
ways to build animations in ArcGIS. Depending on the application (ArcScene, ArcGlobe, or ArcMap) you are
working in, some of the tools may not be available on the Animation toolbar. For example, the Move Layer
along Path option is available in ArcScene only. Explore the Animation help files located the Mapping and
Visualization section of the ArcGIS Help if you want to learn more about animation concepts.

In the next exercise, you'll learn some basic fundamentals of working with ArcGlobe.
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Exercise 6: ArcGlobe basics
Navigating in ArcGlobe lets you explore your data and teaches you how to
accomplish fundamental tasks that you'll use later.

In this exercise, you'll learn how to use the ArcGlobe navigation tools and set
properties that enhance your viewing experience. This exercise assumes
that you are using default online layers for the globe surface. The online
layers require that you have an Internet connection.

Examining the default layers in ArcGlobe

First, you'll start ArcGlobe and learn what kind of data is included by default.

Steps:

1. Start ArcGlobe by clicking Start > All Programs > ArcGIS > ArcGlobe 10.

2. In the ArcGlobe-Getting Started dialog box, click Browse and set the default geodatabase path
to D:\3DAnalyst\3D_Default.gdb.

If Browse is disabled, be sure to click New Globes to start a fresh template and then click
Browse.

This location will be used for output spatial data generated in the tutorial exercise.

Complexity:
Beginner

Data Requirement:
Installed with software

Data Path:
See Copying the tutorial data

Goal:
Learn ArcGlobe navigation skills and
explore basic properties of the viewing
experience
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3. Click OK to close the Getting Started dialog box.

ArcGlobe starts, and its default online layers are loaded.

Notice which layers are loaded in the globe by looking at the list in the table of contents.

4. Click Customize and click ArcGlobe Options.
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5. Click the Default Layers tab to view all start-up layer options for ArcGlobe.

This data is installed from ArcGIS Online as a World Imagery (3D) layer file and also includes a
layer for boundaries and places, a layer for transportation, an elevation layer for the contiguous
United States at a resolution of about 30 meters, and an elevation layer at approximately 90
meters or 1 km per pixel resolution for the world. Therefore, we will use default online layers for
ArcGlobe.

The default online layers are live Internet layers so they require that you have an Internet
connection.

6. Click OK.

7. Click the List By Type button in the table of contents.
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ArcGlobe categorizes layers according to their type. Layers are classified as either elevation,
draped, or floating. Elevation layers provide relief to the globe's surface. Draped layers use the
globe surface as the source of their base heights. Floating layers display independently of the
globe surface and can be draped on discrete surfaces or derive their elevation from attributes or a
constant value.

Now, look how the default layers are categorized—they are listed as draped and elevation layers
and therefore display directly on the globe surface.

Adding more layers

Default layers serve as a background to any data that you want to add to ArcGlobe. Next, you'll add some
local data for the Las Vegas area.

Steps:

1. On the right side of the ArcGlobe window, move your pointer over the Catalog tab or click the
Catalog tab.

The Catalog window slides into the view, ready for use.

You can also click the Catalog window button from the Standard toolbar.

2. Navigate to the Exercise6 folder in the Folder Connections path where you locally saved the
tutorial data.

3. Click las_vegas_area.img, then press SHIFT and click las_vegas_strip.img from the bottom
contents view.

The multiple layers are selected.

4. Drag both selected layers into the 3D view of ArcGlobe, then release the mouse button.

The image layers are automatically added into the table of contents as draped layers. You'll
explore them later in this exercise.
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Changing a layer's drawing priority in the table of contents

Draped layers that have overlapping extents need to have a drawing priority set so one layer gets drawn on
top of the other. ArcGlobe makes some assumptions to accomplish this using criteria such as the cell size of
a raster layer. Occasionally, you'll need to override the ArcGlobe default drawing priorities. One way to do
this is to change the order of draped layers as they appear in the List By Type view of the table of contents.

The drawing priority of draped layers in the ArcGlobe table of contents is designed so that the top-most layer
in the list is the top-most layer on the globe. For instance, if you were to drag a layer from the bottom of the
list to the top, it would now be rendered on top of all your other layers. This technique can help enhance a
view if, for example, you want to display points of interest on top of imagery.

Steps:

1. Right-click las_vegas_area.img and click Zoom to Layer.

You cannot see the image due to a drawing priority set, so the default Imagery layer gets drawn
on top of the _vegas_area.img layer.
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2. Click and hold las_vegas_area.img and drag it so it is above the lmagery layer.

A black line indicates where the layer will be placed.

3. Release the mouse pointer to drop the layer in its new position.

Now, you can see las_vegas_area.img in the center of the view.
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Navigating in Globe mode

ArcGlobe has two viewing modes: Global and Surface. Global mode allows you to navigate your data in the
realm of the whole globe and sets the camera target to the center of the globe. Surface mode lets you work
with your data at a lower elevation, allows additional perspective viewing characteristics, and sets the
camera target on the surface of the globe. You’ll learn how to navigate in Global mode first, then in Surface
mode.

The Navigate tool is active when you start ArcGlobe. You can see the names of other tools on the Tools
toolbar by hovering the pointer over the tool.

Steps:

1. Click the Full Extent button.

The globe displays at full extent.

2. Click the globe, slowly drag up and to the right, then release the mouse pointer.
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The globe rotates, and the view angle lowers so you gain a different vantage point.

3. Right-click and drag down.

The pointer changes to the Zoom In/Out pointer, and the view zooms in on the globe. To zoom
out, right-click the globe and drag up.

4. Click Full Extent .
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Turning on the Spin toolbar

You can use the Spin toolbar to automatically spin the globe clockwise or counterclockwise at any speed
you wish.

Steps:

1. Right-click the menu area and click Spin.

The Spin toolbar appears as an undocked toolbar.

Using the Spin tools

Steps:

1. Click the Spin Clockwise button.

The globe continuously spins clockwise around the z-axis. You can change the speed at which it
spins.

2. Click the top arrow on the Speed text box to increase the rate at which the globe spins.

Continued clicks will incrementally increase the spin rate. You can also type in a value. Click the
bottom arrow to decrease the rate.

3. Click the Stop button to stop the globe from spinning.

You can also press ESC to stop the globe from spinning.

Finding places on the globe

If you have an Internet connection, you can find world locations by using the ESRI Online Place Finder in
the Find dialog box.

Steps:

1. Click the Find button.
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2. Click the Locations tab.

3. Click the Choose a locator drop-down list and click World Places (ArcGIS Online).

4. Type Las Vegas in the Place Name text box.

5. Click Find.

6. Right-click Las Vegas, Nevada, United States, and click Create Bookmark.

7. Right-click Las Vegas, Nevada, United States, and click Zoom To.
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8. Click Cancel to close the Find dialog box.

The Find tool is an easy way of locating almost any place in the world. Use it to locate points of interest,
then use bookmarks to save perspectives of these places.

Now that you're zoomed close to the globe surface, you'll learn how to navigate in Surface mode.

Navigating in Surface mode

When you zoom in close to your data, you can switch to Surface mode to make your navigation apply more
correctly to your new environment. Switching to Surface mode places the camera target on the globe
surface and gives you a sense of 3D perspective while you navigate your data.

Steps:

1. Right-click las_vegas_strip.img in the table of contents and click Zoom To Layer.

The display zooms to the well known "Strip" area of Las Vegas.
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2. Press CTRL and click the center of the roof of the Monte Carlo building.

The point you clicked is moved to the center of the display.
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Centering on a target sets a target on the globe surface and switches to Surface mode.

3. Press CTRL and right-click the center of the roof of the Monte Carlo building again.
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The target is centered, and the display is zoomed to it.

4. Click the Navigate button.

5. Click the bottom of the display and slowly drag up.

An on-screen icon is displayed to help locate the new axis point.

The globe rotates, and the viewing angle lowers. The horizon becomes visible with a light blue
background, and you view the globe in a new perspective.

6. Click the Full Extent button to return the globe to its full extent position.

Setting preferences

You can modify the way ArcGlobe functions at both the application and globe levels. First, you'll explore
some application-level options.

Steps:

1. Click the Customize menu and click ArcGlobe Options.
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The ArcGlobe Options dialog box is where you set application level preferences. The settings
will be preserved in all instances of ArcGlobe.

2. Click the General tab.

3. Check Animate viewer when using tools and commands.

This option shows smooth transitions from one view to the next when you use tools that change
your perspective. This will be the standard behavior every time you start ArcGlobe until you turn
off the option.

4. Click OK to close the dialog box and apply the setting.

5. Click Bookmarks and click Las Vegas.

The display moves to the Las Vegas bookmark in a smooth, animated transition. Next, you'll
examine a document-level option.
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Setting a document-level option

Steps:

1. Double-click Globe Layers in the table of contents.

2. Click the Background tab.

3. Click the Sky color drop-down arrow and click a color of the morning or evening sky.

Sky color is the color of the background when you zoom in close to your globe as defined by the
lower limit of the transition zone.

4. Click OK.
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If you switch to Surface mode and lower the viewing angle, you'll notice the background color
changing to the color you indicated.

In this exercise, you learned how to differentiate between ArcGlobe layer types, navigate in Global and
Surface modes, find places, and set some application and globe properties. Now that you've learned some
fundamentals, you can begin to explore other areas of ArcGlobe. In the next exercise, you'll learn how to use
data as different layer categories.
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Exercise 7: ArcGlobe layer classification
ArcGlobe classifies layers into three types to help you manage them:
elevation, draped, and floating. In this exercise, you'll learn how to use the
classifications to help layers provide the right information to your documents.
This exercise assumes that you are using default online layers, which
require an Internet connection.

If you need to use the system-supplied, coarse layers installed with
ArcGlobe, open the default document where you have installed ArcGlobe,
for example, C:\Program Files\ArcGIS\Desktop10.0\ArcGlobeData. Set the
default layers options, which you learned in exercise 6, to Use my choice of default layers and take a snapshot
of the current document.

Adding elevation layers

Elevation layers provide height information to the globe surface. You'll use rasters with height source
information to provide topography to the surface of the globe and make it look more realistic.

Steps:

1. Start ArcGlobe by clicking Start > All Programs > ArcGIS > ArcGlobe 10.

If you have ArcGlobe already open from a previous exercise, simply click the New Globe File
button to create a new globe surface.

2. In the ArcGlobe-Getting Started dialog box, click Browse and set the default geodatabase path
to D:\3DAnalyst\3D_Default.gdb, if it is not already.

3. If prompted, click No to close the Save changes to Untitled ArcGlobe document warning. If you
are continuing from exercise 6, you do not need to save the previous exercise's results.

ArcGlobe starts, and its default layers are loaded.

4. Click the List By Type button in the table of contents to show the default layer classifications.

5. Right-click Globe layers, point to Add Data, then click Add elevation data.

Complexity:
Beginner

Data Requirement:
Installed with software

Data Path:
See Copying the tutorial data

Goal:
Differentiate the ArcGlobe layer types:
Draped, Floating and Elevation, and set
properties to improve their display
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This indicates that you want to add a specific type of data to that layer category.

6. Navigate to the location of the Exercise7 folder.

7. Select sw_usa_grid.

8. Click Add.

The raster is added to the elevation category and will be used as a source of elevation for the
globe surface.

Adding draped layers

Draped layers are placed on the globe surface and use any elevation data present to show base heights.
Next, you'll add images that will be draped on the globe surface in the area you added elevation data.

Steps:

1. Right-click Globe layers, point to Add Data, then click Add draped data.
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Layers you now add will follow the globe surface.

2. Click angelus oaks.tif, press CTRL, then click socal_mmosaic.sid.

Both layers are selected.

3. Click Add.

If prompted with Create pyramids for angelus oak.tif message box, click Yes to create pyramids
for rapid display at varying resolutions.

Close the Geographic Coordinate Systems Warning message box. The data will be projected
to ArcGlobe's currently set Geographic Coordinate System.
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4. Right-click angelus oaks.tif and click Zoom To Layer.

The display zooms to the extent of the layer. A few moments will pass before the layer is shown at
full resolution as the on-demand cache is built. Once the cache is built, you'll be able to revisit the
area and display the layer quickly.

5. Click and hold the socal_mmosaic.sid layer and drag it so it is just above the Imagery layer in the
table of contents.

A black line indicates where the layer will be placed.

6. Release the mouse pointer to drop the layer in its new position.
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The socal_mmosaic imagery is being displayed on top of the Imagery layer due to its higher
drawing priority

Setting a target to initiate Surface mode

Steps:

1. Press CTRL and click the middle of the display.
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You've initiated Surface mode and set a target at the location on the globe surface where you
clicked.

2. Click the bottom of the display and slowly drag up.

The globe surface you created becomes discernible as you investigate the imagery you added.

3. Click the Full Extent button to return the display to the original view.
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Adding floating layers

Floating layers are layers that float independently of the globe surface. Next, you'll add a raster as a floating
layer and set it to elevations not connected with the globe surface.

Steps:

1. Right-click Globe layers, point to Add Data, then click Add Floating Data.

2. Click o3_99x10k.

o3_99x10k is a raster showing average annual ozone concentration for 1999 in California.

3. Click Add.

The layer is added to the floating category.

Close the Geographic Coordinate Systems Warning dialog box. The data will be projected to
ArcGlobe's currently set Geographic Coordinate System.
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Setting elevation properties of floating layers

Steps:

1. Right-click o3_99x10k and click Properties.

2. Click the Elevation tab.

3. Click Floating on a custom surface.

4. Click the drop-down arrow and click sw_usa_grid.

5. Type 5000 in the Add a constant elevation offset in meters text box.
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6. Click the Symbology tab.

7. Select the red to blue color ramp from the Color Ramp drop-down arrow.

8. Check Invert.

This inverts the color ramp so that high values will be displayed as red, low values as blue.
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9. Click OK.

You've set the raster to use its own values as a source of base heights, offset those heights 5,000
meters from the globe surface, and symbolized the concentration values with color. Next, you'll
take a look at how this appears in the display and set a vertical exaggeration to accentuate the
elevation.

Setting a vertical exaggeration factor for floating layers

Steps:

1. Right-click o3_99x10k and click Zoom To Layer.
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The layer is displayed in the view.

2. Click the Navigation Mode button to change the mode to Surface navigation.

3. Click the bottom of the display and slowly drag the mouse pointer up.
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This allows you to see the effect of changing the vertical exaggeration.

4. Double-click Globe layers.

5. Click the General tab.

6. Select or type a value of 10 for vertical exaggeration Of floating layers.
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The floating layer will be exaggerated by a factor of 10.

7. Click OK.

Examine the floating layer you created. You'll see a 3D raster showing average ozone
concentrations in California in 1999. The layer floats above the state of California and is a surface
that is different from the terrain below. Applying 3D raster layer transparency is useful for
overlapping data such as terrain or aerial photography, and a pollution raster as shown here.
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In this exercise, you learned how to differentiate layer types in ArcGlobe, saw the effect they have on the
globe, and set properties to improve their display. Explore the Exercise7.3dd globe document in the Exercise7
folder to discover additional ways to enhance your globe documents. The document contains layers saved
with custom settings, bookmarks, globe lighting, and animation tracks.
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Exercise 8: Creating and using a terrain dataset
A terrain dataset is a multiresolution TIN-based surface derived from
measurements stored in one or more feature classes in a geodatabase.

In this exercise, you will use geoprocessing tools to load surface data into a
geodatabase, construct a terrain dataset, and use the terrain inside ArcMap
and ArcGlobe.

Loading surface feature data into a geodatabase

In this scenario, you have lidar points and photogrammetric breaklines stored in two separate ASCII text
files. This data will be used to construct your terrain dataset. To accomplish this, you need to import them
into feature classes that reside in a feature dataset. The terrain will be generated in the same location as the
source data.

You've been provided with a file geodatabase with a feature dataset. It contains two polygon feature
classes: one is for lakes, the other to delineate the study area. The initial step will be to import the two ASCII
files into the feature dataset as feature classes: one feature class will delineate the photogrammetric
breaklines, while the other feature class will contain the lidar points.

Steps:

1. Start ArcCatalog by clicking Start > All Programs > ArcGIS > ArcCatalog 10.

2. Click Customize > Extensions.
The Extensions dialog box opens.

Verify the 3D Analyst option is enabled. If it's not, check it and close the dialog box.

Complexity:
Intermediate

Data Requirement:
Installed with software

Data Path:
See Copying the tutorial data

Goal:
Use lidar data to construct a terrain
dataset
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3. In the Catalog Tree, navigate to the Exercise8 folder and double-click terrain.gdb to open the
geodatabase.

4. Double-click the topography feature dataset.

5. In the Catalog Tree, navigate to the 3D Analyst toolbox by expanding Toolboxes > System
Toolboxes > 3D Analyst Tools.
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To expand a toolboxes means clicking the plus sign next to the name. It will expand to view the
toolbox's contents.

6. Expand the Conversion toolset, then From File tools, then double-click the ASCII 3D to Feature
Class tool.

The ASCII 3D to feature class geoprocessing tool dialog box opens.

Next, you'll convert the ASCII points from a simple text file in XYZ format into a multipoint feature
class. These points only define surface geometry, and the attributes only contain x-, y-, and z-
values. A multipoint feature class stores one point per line, and the coordinates are separated by
spaces. Since there is no attribution associated with these points, dedicating a database row for
each is wasteful and inefficient. Instead, you'll combine them into multipoints. A multipoint can
store many points per shape or row, saving storage space and improving read-write performance.

7. In the ASCII 3D to Feature Class tool, make sure the Browse for drop-down list is set to Files.

8. Click the Browse button next to the Input field, navigate to the Exercise8 folder, and choose the
masspoints.xyz file as input.
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9. Make sure Input File Format is set to XYZ.

10. Click the Browse button for the Output Feature Class and navigate to the topography feature
dataset.

Name the output feature class topo_mass_points and save it inside the topography feature
dataset.

11. If it is not done already, set the Output Feature Class Type to MULTIPOINT.

12. Type inside the text box for Average Point Spacing and set the value to 10.

The point spacing represents the average distance between measurement points. Sometimes this
is referred to as nominal point spacing. This is given in the x,y units of the data.

The average point spacing option is only available when the Output Feature Class Type
parameter is set to MULTIPOINT. It facilitates the clustering of points so that each output
multipoint is made from points that are relatively close to one another.

13. Accept all other defaults and click OK to execute the geoprocessing tool.

In the next step, you'll use the same ASCII 3D to Feature Class tool to import the ASCII breakline
data.

Breaklines are linear features, such as roads and water body shorelines, that need to be
represented on the surface. The breaklines are provided in the 3-D GENERATE format—an ASCII
format similar to XYZ but more appropriate for line and polygon data.

You can find a detailed description of the GENERATE format in the desktop help. To find it, click
the Learn more about link located at the top of the help page for the ASCII 3D to Feature Class
tool.
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14. Double-click ASCII 3D to Feature Class to open the geoprocessing tool.

15. Make sure the Browse for drop-down list is set to Files.

16. Click the Browse button and choose the breaklines.lin file as input.

17. Set the Input File Format to GENERATE.

18. Click the Browse button for the Output Feature Class and browse to the topography feature
dataset. Name the output feature class topo_break_lines.

19. Set the Output Feature Class Type to POLYLINE.

20. Click OK to execute the geoprocessing tool.

You will now preview to confirm that the breaklines have been created correctly.

21. Click to select the topo_break_lines feature class in the catalog tree.

22. Click the Preview tab to view the breakline data.
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23. Make sure the Preview type is set to Geography. The preview should resemble the breakline
data displayed in the above image.

Now you've loaded the mass points and breaklines from which a terrain dataset will be built. The lidar points
came in XYZ format and the photogrammetric lines in 3-D GENERATE format. Both are ASCII formats for
simple 3D data and are read using the same tool, ASCII 3D to Feature Class.

Note: • If you need to process a large collection of lidar points, consider using
the LAS format instead of XYZ. LAS is an industry-standard format for
lidar data. It's more efficient because it's binary. It also has more
information stored in the file about the data.

• There's a separate tool to import LAS format files, LAS to Multipoint,
that's located in the same toolset as the ASCII 3D to Feature Class
tool.

Building a terrain dataset from features

Next, you will use the New Terrain wizard in ArcCatalog to define and build a terrain dataset.

Steps:
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1. In ArcCatalog, right-click the topography feature dataset, point to New, and select Terrain from
the context menu.

Terrains are located in feature datasets. Terrains, and the feature classes used to build them,
must reside at the same location. One benefit of using the feature dataset as a container is that it
ensures that all the data used to build a terrain has the same spatial reference. In an SDE
database, it's also the organizational level at which data gets registered as versioned for editing.

2. In the New Terrain dialog box, accept the default name for the terrain dataset.

3. Click Select All to check all the feature classes that are in the feature dataset.

4. Set the Approximate point spacing to 10.

5. Click Next.

You will next indicate how each feature class will contribute to the terrain.

6. Click the Advanced button to expand the list of columns.
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7. Set the Surface Feature Type (SFType) to hard line for the topo_water_poly feature class.

The features of the topo_water_poly feature class should be incorporated into the surface as hard
lines.

Since the mass points and breaklines have z-values, which will be used to define the terrain
surface, the height source for them is set to Shape. This means that z comes from the shape
geometry.

The topo_clip_poly feature class contains a 2D polygon. It defines the horizontal extent of the
surface and minimizes interpolation artifacts around the surface perimeter.
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Clip polygons work best when they're smaller than the extent of the data that is being used to
provide z-values. The water polygons are represented by 2D geometry but have the height
attribute SPOT. Each polygon can have its own height, but that height is constant. For lakes, this
is fine, since they're flat. With this data, there are no measurements inside the lake boundaries
that contradict the lake SPOT values, so you can add the boundaries as breaklines; otherwise,
they'd be added as replacement polygons to ensure that their areas get flattened.

Everything but the breaklines are used for the terrain's overview representation. The overview is a
generalized representation of the terrain, similar to a vector-based thumbnail. The breaklines are
too detailed for the overview, but all the other information is needed to produce a reasonable
looking overview.

8. Click Next to determine the terrain pyramid type.

Defining the pyramid for the terrain dataset

Terrain pyramids are used to create multiresolution surfaces. They're similar to raster pyramids in concept
(that is, coarser pyramids are used for display at smaller scales to improve display performance), but there
are differences. The most significant are that they're composed of vector based measurements and they can
be used for analysis as well as display.

Two types of pyramids can be used to build a terrain dataset: z-tolerance and window size.

Z-tolerance pyramiding thins points to produce surfaces that are within an approximate vertical accuracy
relative to the full-resolution data.

The window size pyramid type thins points for each pyramid level by partitioning the data into equal areas
(windows) and selecting just one or two points from each area as representatives. Selection is based on one
of the following criteria: the minimum, maximum, mean, or both the minimum and maximum z-value.

Steps:

1. Click the radio button next to the Z-tolerance pyramid type.
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The z-tolerance pyramid type is defined using two factors: z-tolerance and reference scale.

The z-tolerance of an individual pyramid level represents its approximate vertical accuracy relative
to the full-resolution data. The reference scale of a pyramid level defines the display scale at
which it becomes active.

2. Click Next to define the terrain pyramid levels.

3. Click Add four times. This populates the table for you to customize the properties.

4. Manually reset the values for Z Tolerance and Maximum Scale by clicking the values inside
each column. Use the values specified in the following graphic.
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Using these settings, the full-resolution data is used in map displays up to a scale of 1:2,500.
Between display scales of 1:2,500 and 1:10,000, only the data necessary to achieve an
approximate vertical tolerance of 1.0, relative to the full-resolution data, is used. Between
1:10,000 and 1:25,000, a tolerance of 2.5 is used. Between 1:25,000 and 1:50,000, a tolerance of
5 is used. For any scale smaller than that, a tolerance of 10 is used.

Tolerances and scales used to define a terrain pyramid need to be specified based on application
requirements. One approach is to mimic the accuracy requirements of a contour map series. A
generally accepted rule is that contours should be accurate to within one-half of their interval. For
example, if a 1:24,000 scale map within your study area uses a 5-foot contour interval, then the
vertical accuracy should be 2.5 units RMSE. Base the pyramid on the scales and contour intervals
appropriate for a map series of the terrain.

While breakline vertices are used where needed through all pyramid levels, the actual line
enforcement can be restricted to occur in a subset of these levels. For example, road curbsides
need not be enforced as triangle edges in a terrain at scales smaller than 1:24,000. You control
enforcement via the Pyramid Bounds dialog box.

5. Click the Resolution Bounds Setting button to open the Pyramid Resolution Bounds dialog
box.

6. Set the Max Z Tolerance for the topo_break_lines feature class to 1. Accept the defaults for all
others.
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In the Pyramid Resolution Bounds dialog box, z-tolerances indicate at which pyramid levels the
enforcement is to take place. Using the given values, the breaklines will be enforced for pyramid
levels with z-tolerances >= 0 and <= 1.0. This translates into the breaklines being enforced only at
scales larger than 1:10,000. The water and clip polygons are enforced through all scales. This
ensures the data boundary is always correct and water bodies remain flat.

7. Click OK to dismiss the Pyramid Resolution Bounds dialog box.

8. Click Next to reach the summary panel.

Review your settings.

9. Click Finish.
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10. You're now asked if you want to build the terrain. Click Yes to initiate the terrain build process.

When the terrain build process is complete, the new terrain is added to the Catalog Tree inside
the feature dataset. Right-clicking the new terrain dataset will expose the properties. You can
preview the terrain dataset in ArcCatalog.

Viewing a terrain in ArcMap

Now that you have created a terrain dataset, adding it as a layer in ArcMap can be used to conduct further
visualization and analysis. You can turn it on and off in the table of contents. As well, it has a Layer
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Properties dialog box to control display parameters. The layer properties Symbology tab is identical to TIN
layers.

Steps:

1. From ArcCatalog, click the Launch ArcMap button on the Standard toolbar to start the
application.

2. In the ArcMap - Getting Started dialog box, click Browse and set the default geodatabase path
to D:\3DAnalyst\3D_Default.gdb.

This location will be used for output spatial data generated in the tutorial exercises.

3. Click OK to close the Getting Started dialog box.

Once ArcMap opens, you can close ArcCatalog.

4. Click the Catalog tab to open the Catalog window, navigate to topography_Terrain from the
Exercise8 folder, drag it into the map view, then release the mouse button.

The terrain draws in the map view, and the topography layer is automatically added into the table
of contents.
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The terrain will retrieve measurements from the database for the pyramid level associated with the
current display scale. The measurements are triangulated on the fly and drawn to the screen.
When going from coarser pyramid levels to more detailed levels, only the additional
measurements needed to get to the higher-detail pyramid level are retrieved and added to the
triangulation.

5. Zoom in on the display.

3D Analyst Tutorial

Copyright © 1995-2010 Esri. All rights reserved. 138



Note how the vertical tolerance associated with the current display is listed in the map's table of
contents.

6. Zoom to the full extent of the layer by clicking the Full Extent button from the Tools toolbar.

Note that Overview Terrain is listed in the table of contents.

The terrain overview is the coarsest representation of the terrain. It's coarser than the lowest level
of detail (LOD) pyramid specified when the terrain was defined.

The overview is used by default when the layer is zoomed out to full extent or beyond. This is
used to speed up rendering. Use of the overview representation can be turned on and off from the
Display tab of the terrain's Layer Properties dialog box. You can also apply a point limit from this
tab.
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The use of a point limit tells the terrain layer to further downgrade its display resolution if the
current environment (that is, display extent, scale, and pyramid definition) would require too many
measurement points. This helps maintain display performance at the cost of not always honoring
the terrain's original pyramid display definition. When the resolution has been downgraded, an
asterisk is displayed next to the terrain layer's name.

7. Double-click the terrain layer to open the Layer Properties dialog box and click the Display tab.

8. Change the point limit from 800000 to 125000 and click OK to close the Layer Properties
dialog box.

9. From the map display, zoom in and out, then pan around.

The display should be consistently fast, because the layer is adjusting which pyramid levels get
used to keep the point count below the 125000 limit.

Using the interactive surface analysis tools in ArcMap

Now you'll use the 3D Interactive tools to complete some surface analysis.

Steps:

1. Make sure the 3D Analyst extension is enabled in ArcMap by clicking Customize, then
Extensions.

2. Click Customize and Toolbars to add the 3D Analyst toolbar, if it is not already displayed. The
terrain is displayed in the Layer list on the toolbar.
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If you aren't zoomed in far enough, the tools on the toolbar are disabled. By default, they're only
enabled when the terrain is displayed at full resolution. Based on how the terrain's pyramid was
defined, this will occur at display scales of 1:2,500 or larger.

You can enable the tools at lower resolutions from the Analysis tab of the terrain's Layer
Properties dialog box. When you enable the tools at LODs lower than full resolution, the accuracy
is also decreased. Interactive tools always operate at the current display resolution. This is useful
if the full-resolution terrain is oversampled for the requirements of the analysis.

3. Double-click the terrain layer to open the terrain Layer Properties dialog box and click the
Analysis tab.

4. Set the resolution threshold for the 3D Analyst tools to 1.000000 from the drop-down menu.

5. Click OK.

6. Zoom in on the terrain until the display scale is larger than 1:10,000.
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The 3D Analyst interactive tools on the 3D Analyst toolbar should now be enabled.

Now you'll conduct a line-of-sight analysis on the surface.

7. Click the Create Line of Sight button.

8. Set the Observer offset to 5 and the Target offset to 2.

The line of sight will be calculated to show what is visible from the perspective of an observer five
meters tall to a target two meters high.

9. Click on the south slope of the mountain in the upper-left part of the terrain (the observer point),
drag the line to the lower-right part, then release the mouse button (the target point).
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The line of sight is calculated. The green segments show areas that are visible from the observer
point; the red segments are hidden from the observer.

10. Click the x in the upper right corner to close the Line of Sight dialog box and press DEL to
delete the graphic from the view.

Now you'll interpolate a 3D line on the surface.

11. Click the Interpolate Line button.

12. Digitize the first point in the left center of the view, drag the line to the upper-right corner to
create the second point, then drag toward to the lower-right corner. Double-click to create the
last point and stop digitizing.

The resulting graphic line will automatically be selected.

A selected 3D polyline enables the Create Profile Graph tool.
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A profile along a line with two segments is created.

13. Click the Profile Graph Tool button to graph the 3D line.

The profile graph is created.

14. Click the x in the upper right corner to close the Profile Graph Title dialog box and press DEL to
delete the graphic from the view.

Rasterize a terrain using a geoprocessing tool

Terrain datasets can be rasterized based on any extent, cell size, and vertical tolerance. You can choose
between linear and natural neighbor interpolators. A natural neighbor interpolation method generally
produces higher-quality results but at the expense of processing time. Rasterization is performed using the
Terrain to Raster geoprocessing tool.

Steps:
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1. From the Catalog window, expand Toolboxes, click System Toolboxes, then click the 3D
Analyst Tools toolbox.

2. Navigate to the Conversion toolset, then the From Terrain tools, and double-click the Terrain to
Raster geoprocessing tool.

3. Choose the topography_Terrain in the Input Terrain drop-down list.

4. Set the other values to match the graphic below.

Type CELLSIZE 10 in the Sampling Distance drop-down list.

5. Click OK to execute the geoprocessing tool

Keeping the Output Data Type as FLOAT will preserve vertical precision.

Changing the interpolation Method to NATURAL_NEIGHBORS will take a little longer than
LINEAR, but it adds some smoothness everywhere except across hard breaklines where sharp
discontinuities are supposed to occur.

Setting an explicit Sampling Distance lets you know exactly what the output cell size will be.
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Since this terrain dataset was made with a z-tolerance pyramid type, the pyramid resolution
represents the z-tolerance of the desired pyramid level. In this terrain, the pyramid level with a
resolution of 1.0 has the breaklines enabled.

This surface will be somewhat generalized relative to the full-resolution data, but not by much, and
this process will run faster because it's using a thinned version of the data.

6. Click Full Extent once the geoprocessing tool has completed to view the results. Turn off the
topography_Terrain layers.

Generate a hillshade using a geoprocessing tool

To see the morphology of the derived raster surface, generate a hillshade image. A hillshade representation
of a surface can greatly enhance the visualization of a surface for analysis or graphical display, especially
when utilizing the transparency setting.

Steps:

1. From the Catalog window, expand Toolboxes and click System Toolboxes, then click the 3D
Analyst Tools toolbox.

2. Navigate to the Raster Surface toolset and double-click the Hillshade tool.
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3. Choose the terrain_grd in the Input raster drop-down list.

4. Confirm that all other values match the graphic below.

5. Click OK to execute the tool and examine the resulting hillshade layer.
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Using a terrain as an elevation layer in ArcGlobe

Terrain datasets can be used in ArcGlobe as either elevation or draped layers, contributing to the definition
of the globe surface.

Steps:

1. From ArcMap, click the Launch ArcGlobe button on the 3D Analyst toolbar to start the
application.

2. In the ArcGlobe - Getting Started window, make sure the default geodatabase path is set to
D:\3DAnalyst\3D_Default.gdb.

This location will be used for output spatial data generated in the tutorial exercises.

3. Click OK to close the Getting Started dialog box.

ArcGlobe starts.

4. Close ArcMap. It is no longer needed for the rest of the exercise.

5. From the Catalog window, navigate to topography_Terrain from the Exercise8 folder, drag it into
the 3D view of ArcGlobe, then release the pointer.
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6. If prompted, close the Geographic Coordinate Systems Warning message box.

The data will be projected to the ArcGlobe program’s currently set Geographic Coordinate
Systems.

The terrain dataset is automatically added as an elevation source in the table of contents of
ArcGlobe. It will not be visible if it is used as an elevation surface to drape additional surfaces on.

7. From the Catalog window, navigate to 3D_Default.gdb and click the geodatabase.

8. In the panel underneath the Catalog's tree view, select the contents of the geodatabase by
holding the SHIFT key. HillSha_terr1 and terrain_grd are selected.

9. Drag both selected layers into the 3D view of ArcGlobe, then release the pointer.
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10. An Add Data Wizard dialog box appears for terrain_grd. Click Finish to use the rasterized
terrain as an image source.

11. A dialog box may appear requesting to build raster pyramids. Click Yes.

12. An Add Data Wizard dialog box appears for HillSha_terr1. Click Finish to use hillshade raster
as an image source.

3D Analyst Tutorial

Copyright © 1995-2010 Esri. All rights reserved. 150



If prompted, close the Geographic Coordinate Systems Warning message box.

The hillshade raster and rasterized terrain layers are automatically added into the table of
contents as draped layers.

13. Click and drag the Imagery layer until a black line appears after the hillshade indicating the new
location. Release the mouse once this line appears.
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14. Right-click the rasterized terrain and click Properties.

15. Click the Symbology tab.

Symbolize the rasterized terrain using an appropriate elevation color ramp.
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16. Click the Display tab.

17. Assign a transparency setting of 50%.
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18. Click OK to close the Layer Properties dialog box.

19. Zoom in to the rasterized terrain and navigate around.
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The hillshade raster can be seen through the rasterized terrain using this transparency setting,
revealing a 3D morphological surface of the terrain dataset.

Optimizing display settings in ArcGlobe

For high-quality display, you can do several things. Go to the Cache tab on the terrain's Layer Properties
dialog box and uncheck the option to compress to 16 bits. This will eliminate the possibility of the surface
geometry looking stair-stepped when zoomed in very close.
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You can also set both the draped layers to use bilinear renderers. These will draw a smoother picture. Also,
the hillshade raster should not use any stretch. The default, using standard deviations, is not appropriate for
this data.
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As an alternative to viewing draped rasters derived from the terrain dataset, you can add the terrain directly
as a draped layer.

To do this, right-click Globe layers from the table of contents, point to Add Data, click Add Draped Data,
then choose the terrain.
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In this exercise, you have been introduced to terrain dataset concepts. You used geoprocessing tools to load
lidar points and photogrammetric breaklines into feature classes residing in a feature dataset. Then, with the
surface data in a feature dataset, you constructed a terrain dataset using the terrain wizard in ArcCatalog. You
then conducted some analysis on the terrain surface inside ArcMap and ArcGlobe.
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Exercise 9: Creating a realistic 3D view
Imagine that you are an urban planner and are interested in constructing a
realistic 3D model of a neighborhood. The staff of the planning and
transportation departments has created GIS datasets for the building
footprints, streetlights, trees, and sample vehicles for this area. You also
have imagery of the area, and an architect has supplied a set of
photorealistic building models.

You want to combine the GIS data with the image and the building models in
ArcGlobe to develop a realistic urban model. This model will help decision
makers visualize proposed buildings and their associated views. Such models can also be used to study
spatial awareness or to simulate urban features, landscapes, landmarks, or tourist attractions for students or
tourists.

This is an advanced exercise illustrating how to use 3D symbology and 3D graphics tools to create a realistic-
looking view of a study area in London.

Opening the London Globe document

Steps:

1. Start ArcGlobe by clicking Start > All Programs > ArcGIS > ArcGlobe 10.

2. On the ArcGlobe - Getting Started dialog box, click Browse and set the globe's default
geodatabase path to D:\3DAnalyst\3D_Default.gdb

This location will be used for output spatial data generated in the tutorial exercises.

3. Next, on the ArcGlobe - Getting Started dialog box, click Existing Scenes > Browse for more .

The Open dialog box appears.

4. Navigate to the Exercise9 folder.

5. Double-click the London_Start ArcGlobe document.

Complexity:
Intermediate

Data Requirement:
Installed with software

Data Path:
See Copying the tutorial data

Goal:
Use 3D symbology and 3D graphics tools
to transform 2D feature datasets into
realistic looking 3D data models
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The ArcGlobe document contains high-resolution images (courtesy of DigitalGlobe QuickBird),
one 3D feature dataset symbolized with tree symbols, and one 3D textured multipatch dataset
representing the buildings in the study area.

6. Click File and click Save As.

7. Type London for the name of the globe document.
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8. Click Save.

Setting the visible distance range of a layer

You can optimize the performance of an ArcGlobe document by setting an appropriate visibility distance for
each layer. Specifying the visibility distance range lets you control when a layer becomes visible as you
zoom in or out. You can either set the minimum and maximum distance for an entire layer, or you can base
the layer visibility on individual tile distances.

The checked box beside the Buildings layer is unavailable in the table of contents. This means the display
currently exceeds the layer's maximum visibility distance. You will change the maximum visibility distance
for a couple of other layers later in this exercise.

Steps:

1. In the table of contents, right-click the Holborn.jp2 layer and click Properties.

2. Click the Globe General tab.

3. Click the Don't show layer when zoomed option.
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4. Type 5 in the Out beyond text box.

The units used for this distance are kilometers.

5. Check visibility based on each tile distance to enable distance visibility for discrete parts of
the layer.

This setting, although not enabled by default, further improves performance. When enabled,
discrete tiles of data appear visible when navigating near their layer's distance threshold.

6. Click OK.

The layer will be visible between the minimum and maximum distance.

7. Click Bookmarks and click City View.

The display is now repositioned to the City View bookmark. All the datasets are now visible,
because you are within the visibility distance range of all layers at this scale.
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A layer's visibility range can also be set according to current display distances. Right-click a layer
in the table of contents, point to Visible distance range, then use the Set Maximum Distance
and Set Minimum Distance commands to capture display distances.

Tips on allocating memory cache

Often, an ArcGlobe document that is performing poorly can be made interactive through a well-defined
memory cache. This is a specified amount of physical memory (RAM) dedicated for exclusive use by
ArcGlobe to improve performance. For optimum performance, the memory cache can be fine-tuned
according to the individual data types used. As this exercise uses many 3D textured objects and raster
images, your next step will be to allocate a greater percentage of the memory cache to improve handling of
these data types.

Steps:

1. Click the Customize menu and click ArcGlobe Options.

2. Click the Display Cache tab.

3. Click the Advanced button.
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4. Take a glance for the memory allocation values, in megabytes, and types.

Each data type's current memory usage as an absolute value and as a percentage of its allocated
size is detailed in the text box and horizontal graph to the right of each item.

The total memory cache size is calculated as the sum of the individual data type settings. This
total cannot exceed the amount of physical memory (RAM) installed on your machine.
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If necessary, click the Balance Current Usage button to prevent the size of the memory cache
from exceeding your available physical memory (RAM).

The Balance Current Usage button will automatically balance the allocation of memory used for
each data type, based on the current memory usage of the document.

If you allocate a small amount of physical memory (RAM) to a particular data type and
subsequently create a document that makes extensive use of this data type, it will start paging the
data to disk well before physical memory is exhausted, leading to reduced performance.

You will utilize this tool after you have fully authored the 3D view and have interacted within it for a
while to ensure that the memory allocation applied best represents the kinds of data you have in
the document.

5. Click OK to close the Advanced Memory Cache Settings dialog box.

6. Click OK to close the Options dialog box.

Adding feature data

To create 3D objects on your model, you will add some local data to the London area.

Steps:

1. Click the Add Data button.
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2. Navigate to the location of the Exercise9 tutorial data folder.

3. Open the Geodatabase folder and double-click the Lincolns.gdb geodatabase file.

4. Holding down the CTRL key, click the Building_Footprints, Street_Lights, and Vehicles feature
classes.

Holding down the CTRL key lets you select multiple items.

5. Click Add.

A sequence of three Add Data Wizards will appear for each feature layer beginning with
Building_Footprints.

6. Click Don't show layer when zoomed to apply the distance visibility range.

7. Type 3 in the out beyond text box, and leave the in beyond text box set to the default value of
0.
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8. Click Finish.

9. Click Display features as 3D vectors when the Add Data Wizard appears for Street_Lights
layer.

10. Click Next.

11. Click Don't show layer when zoomed to apply the distance visibility range. Then type 1 and 0
in the distance range text boxes.

12. Click Next.
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13. Select the typical scale at which this layer will be seen in real-world units.

14. Click Finish.

15. Repeat steps 9 through 14 for the Vehicles layer.

If prompted, close the Geographic Coordinate Systems Warning message box. The data will
be projected to the ArcGlobe program's currently set Geographic Coordinate Systems.

16. Click Bookmarks and click Bird View.

Now you can see all the layers you have added to the study area. The table of contents indicates
that these feature layers have been added as draped layers in the 3D view.
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Extruding buildings

Features in a two-dimensional data source can be projected into a three-dimensional representation through
a process known as extrusion. A 2D building footprint, for example, can be extruded into a 3D block
representation of that building. In this exercise, you will extrude building polygons according to a height
value governed by the number of floors and average height per floor to create realistic 3D building shapes.

Steps:

1. In the table of contents, right-click Building_Footprints layer and click Properties.

2. Click the Globe Extrusion tab.
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3. Check Extrude features in layer.

4. Click the Calculate Extrusion Expression button to open the Expression Builder dialog box.

5. Click the attribute NUM_FLOORS to add it to the Expression text box.

6. Assuming that each floor has a height of 4 meters, you can calculate the height of each building
by multiplying the number of floors in each building by 4.

Set the expression to [NUM_FLOORS] * 4 to reflect the following graphic.
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7. Click OK.

8. Click OK to close the Layer Properties dialog box.

The 2D building footprint features are now extruded into 3D blocks.

Optionally, to increase performance, you can choose not to draw the bottom faces of extruded
polygons.

Navigate around the display to view your results.
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Symbolizing features

Steps:

1. In the table of contents, right-click the Street_Lights layer and click Properties.

You can also open the Layer Properties dialog box by double-clicking the layer.

2. Click the Symbology tab.

3. Click Categories.

ArcGlobe automatically selects the Unique values option.

4. Click the Value Field drop-down arrow and click MODEL.

5. Click Add All Values.

This adds all unique values to the list. You could also have clicked the Add Values button to
choose specific Model values to display.

6. Double-click the symbol for stlght13.
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7. In the Symbol Selector dialog box, click the Style References.

8. In the Style References dialog box, check 3D Buildings, 3D Street Furniture, and 3D Vehicles
then click OK.

Styles are a collection of symbols, colors, map elements, and other graphical elements stored in a
library to use inside ArcGIS.

9. In the Symbol Selector dialog box, click inside the Search combo box and type street
light, then press Enter.

10. Click the Street Light 13 symbol.

11. Type 8 in Size text box.
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12. Click OK.

13. Double-click the symbol for stlght7.

14. Repeat steps 9 through 12, except type 5 for the size, and assign Street Light 7, or another
street light symbol you prefer.

15. In the Layer Properties dialog box, click the Advanced button and click Rotation.

16. Click the Rotate Points by Angle in this field drop-down list and click Angle.
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17. Click OK.

18. Click OK on the Layer Properties dialog box.

19. In the table of contents, double-click the Trees layer.

Make sure the Symbology tab is selected.

20. In the Layer Properties dialog box, click the Advanced button and click Rotation.

21. Click the Rotate Points by Angle in this field drop-down list and click random.

22. Click OK.
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23. In the Layer Properties dialog box, click the Advanced button and click Size.

24. Click the Size Points by Value in this field drop-down list and click random.

25. Type 6 in the Minimum box and 15 in the Maximum box.

26. Click OK.

27. Click OK on the Layer Properties dialog box when you have finished.

The random values of rotation and size will be generated between the minimum and maximum
random values specified for the trees.

Matching symbols in a style

The symbols in a style have names. If your features have values that match these names, you can
automatically associate a particular symbol with each matching feature. If your features use a different set of
names, you can edit the names in the style to match them.

Steps:

1. In the table of contents, right-click the Vehicles layer and click Open Attribute Table.

In the Table window, notice the Model column. Each vehicle type listed corresponds to a symbol
with the same name.
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2. Close the Table window.

3. Double-click the Vehicles layer to open the Layer Properties dialog box.

4. Click the Symbology tab.

5. Under Categories, click Match to symbols in a style.

6. Click the Value Field drop-down arrow and choose MODEL.

7. Click the Match to symbols in Style drop-down list and choose 3D Vehicles.style.

You can also click Browse to navigate to the 3D Vehicles.style file in the C:\Program
Files\ArcGIS\Desktop10.0\Styles folder and click Open. Match to symbols in Style will now be
populated with this style file.
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8. Click Match Symbols.

This adds all unique values that have a matching symbol in the style.

Alternatively, by clicking Add Values, you can manually specify which unique values to display.
You can also manually edit a label if you would like more descriptive labels to appear in the
legend and the table of contents. This does not change the name in the attribute table.

9. Click the Advanced button and click Rotation.

10. Click the Rotate Points by Angle in this field drop-down list and click Angle.

11. Click OK.

12. Click OK again to close the Layer Properties dialog box.

Navigate around the neighborhood to view the results.
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Using the graphic tools

Sometimes you need to show something that isn't represented among your GIS features. You can add
graphics to ArcGlobe and display them with the same realistic symbols that you use for features. You can
digitize 3D graphics to represent points of interest, lines to delineate boundaries or roads, polygons that fill
an open area, or text to name or describe places. To do so, you need to add the Globe 3D Graphics toolbar.

Steps:

1. Click Customize, point to Toolbars, and select Globe 3D Graphics.

The Globe 3D Graphics toolbar appears.

2. If you want to dock the toolbar along with other toolbars, simply drag it to the desired location.

You can also add/remove toolbars by right-clicking on a toolbar or in the gray area where toolbars appear.
This opens the toolbar list. The visible toolbars are checked.

Creating a graphic layer

You can control the visibility of graphics by storing them in a named graphics layer. The graphics layer will
be listed in the ArcGlobe table of contents, where you can turn it on and off like other layers.

Steps:

1. Click Bookmarks and click City Hall.

2. On the Globe 3D Graphics toolbar, click Graphics and click New Graphics Layer.

The New Graphics Layer is added to the table of contents under Draped layers.

3. Double-click the New Graphics Layer to open the Layer Properties dialog box.

4. Type My Buildings in the Layer Name text box.
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5. Check Don't show layer when zoomed.

6. Type 3 in the out beyond text box.

7. Click OK.

Setting the target layer and digitizing a 3D point graphic

Steps:

1. On the 3D Graphics toolbar, click the Graphics menu, point to Active Graphics Layer Target,
and make sure the My Buildings layer is selected.

All new graphics will be added to this layer.

2. Click the Graphics drop-down menu and click Default Element Properties.
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3. Click the Marker button.

The Default Marker Element Properties dialog box opens.

4. Click the Effects tab.

5. Uncheck Fixed screen size.

The fixed screen size option will not scale vector point graphic elements when you zoom in and
out. It is unchecked here so the point graphic element will stay the same size in relation to the
globe as you zoom in and out.

6. Click OK.

7. Click OK to close the Default Element Properties dialog box.

8. On the Globe 3D Graphics toolbar, click the New Marker tool.
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3D point graphics can be symbolized with 3D marker symbols. You can choose these symbols
from existing styles. This is an easy way to add realistic objects to your 3D model without editing
your GIS features. Now you will add a 3D symbol for the city hall in London.

9. Add a point as highlighted in the following graphic.

A point graphic is drawn at the location you digitized.

10. Click the Select Graphics tool.

11. Right-click the point and click Properties.

12. On the Symbol tab, click Change Symbol.
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13. In the Symbol Selector dialog box, click inside the Search combo box and type city hall,
then press Enter.

14. Click the City Hall 1 symbol, and type 25 in the Angle box.

15. Click Edit Symbol.

16. In the Symbol Property Editor, make sure that the 3D Marker tab is selected.

17. Uncheck Keep aspect ratio to allow the dimensions of the 3D symbol to be freely adjusted.

18. Under Dimensions, type 70 in the text box for Depth (Y).
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The dimension of the cityHall1 symbol is modified in the 3D Preview window.

19. Click the 3D Placement tab.

20. Type 3 for the X offset, and -5 for the Y offset.
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The 3D symbol is offset in the x,y plane depending on the values supplied for x- and y-values.

21. Click OK.

22. Click OK to close the Symbol Selector dialog box.

23. Click OK to close the Properties dialog box.

24. Unselect the city hall symbol and navigate around the display to view the result.

To unselect a graphic, use the Select Graphics tool and click away from the symbol. Or, click the
Clear Selected Features button.

Digitizing text graphics

Once you have added the city hall symbol to the scene, you may find it useful to add a text annotation in the
same view. The text graphic element allows one to digitize 2D or 3D text in the scene.

Steps:

1. Click Bookmarks and click City Hall.

Zoom in to the roof of City Hall.

2. On the 3D Graphics toolbar, click the Graphics menu and click Default Element Properties.

3. Click the Text button.

The Default Text Element Properties dialog box opens.
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4. Click the Text tab.

5. Click the Change Symbol button to open the Symbol Selector dialog box.

6. Click on Color drop-down arrow and choose Solar Yellow color from style palette.
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The mouse tip displays the color name in the style palette.

7. Click OK to close the Symbol Selector dialog box.

8. Click the Effects tab on the Default Text Element Properties dialog box.

9. Uncheck Pin to surface.
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Pin to surface is useful if you want to fix the text graphic to the underlying globe surface. In this
case, we want to digitize the text on the roof of the City Hall.

10. Click OK to close the Default Text Element Properties dialog box.

11. Click OK to close the Default Element Properties dialog box.

12. On the 3D Graphics toolbar, click the New Text tool.

13. Click on the roof of city hall graphic.

14. Type City Hall in the text box and press Enter.
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15. Unselect the text element and navigate around the display.

The text appears at the location you clicked.

Adding and modifying a 3D graphics layer

Steps:

1. Click the Add Data button.

2. Browse to the Exercise9\GeoDatabase folder.

3. Double-click the Street Objects layer to add it to ArcGlobe.
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4. Click Bookmarks and click Street View.

5. On the Globe 3D Graphics toolbar, click the Graphics menu, point to Active Graphics Layer
Target, then click Street Objects Layer.

6. Click the Graphics menu and click Default Element Properties.

7. Click the Marker button.

8. On the Symbol tab, click Change Symbol.

9. In the Symbol Selector dialog box, click inside the Search combo box and type traffic
cone, then press ENTER.
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10. Click the Traffic Cone 1 symbol.

11. Click OK.

12. Click OK to close the Default Marker Element Properties dialog box.

13. Click OK to close the Default Element Properties dialog box.

14. On the 3D Graphics toolbar, click New Marker.

15. Click three times to add three markers in front of the first 3 cars as shown here.
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16. Right-click the Street Objects Layer in the table of contents and click Save As Layer File.

17. Navigate to Exercise9\GeoDatabase, select the Street Objects layer file, and click Save.
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Click Yes if prompted to overwrite the existing file. The new markers you created are stored in the
Street Objects layer.

Final view

You have successfully created a realistic 3D view of a small area within London. You can use one of the
many navigation tools available, such as navigate, pan, and zoom, to browse the scene. You can also use
the fly tool to fly over your city model.
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Balance the memory cache for final view

Steps:

1. Click the Customize menu and click ArcGlobe Options.

2. Click the Display Cache tab.

3. Click the Advanced button.

Take a glance for each type of the memory values in megabytes. You will see that the memory
cache size of 3D Objects (texture) is exceeding its limit.
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4. Click the Balance Current Usage button.

The total amount of memory assigned to ArcGlobe is redistributed (using the current percentage-
of-use per memory type), allowing very quick optimization of the memory settings for the current
document.

A minimum amount of 10 MB of memory is guaranteed for each type. Saving the ArcGlobe
document will ensure these optimized memory settings are honored whenever the document is
opened in the future.
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In this exercise, you learned how to transform 2D feature datasets into realistic-looking 3D data models. This
exercise also focused on accessing symbol libraries for styles to match layer attributes. You can quickly
personalize your scene with several symbol property options.

Finally, the 3D graphics toolbar is a host of many tools necessary to create and edit new 3D graphics layers
and features. You are well on your way to adding realism to your 3D scene by using 3D graphics tools and
symbology options available within ArcGlobe.

3D Analyst Tutorial

Copyright © 1995-2010 Esri. All rights reserved. 196


	Table of Contents
	Introduction to the ArcGIS 3D Analyst tutorial
	IN THIS TUTORIAL
	
	DATA CREDITS

	Copying the tutorial data
	Copying the tutorial data

	Exercise 1: Draping an image over a terrain surface
	Turning on the 3D Analyst extension
	Previewing 3D data in ArcCatalog
	Starting ArcScene and adding data
	Draping the image
	Exploring the image
	Exaggerating the terrain
	Saving the scene

	Exercise 2: Visualizing contamination in an aquifer
	Opening the Groundwater scene document
	Showing the volume and intensity of contamination
	Showing the relationship of the plume to wells
	Showing the facilities with a high cleanup priority

	Exercise 3: Visualizing soil contamination and thyroid cancer rates
	Viewing the point data
	Creating 3D point features
	Increasing the vertical exaggeration
	Extruding columns
	Creating a surface from point sample data
	Viewing the interpolated surface
	Selecting features by an attribute
	Viewing the attributes of features

	Exercise 4: Building a TIN to represent terrain
	Viewing the cave and the landscape
	Creating a TIN from point data
	Adding features to a TIN
	Setting feature base heights from the TIN
	Setting raster base heights from the TIN
	Cleaning up the scene
	Creating a profile of the terrain
	Creating a line of sight on the terrain

	Exercise 5: Working with animations
	Opening the Final Animation_A scene document
	Playing the scene’s animation
	Opening the Animation scene document
	Capturing perspective views as keyframes to make an animation
	Playing back your animation
	Clearing an animation
	Recording navigation
	Making a camera track from 3D bookmarks
	Switching the visibility between layers using a group animation
	Using the Animation Manager to disable a track from playing
	Using Animation Controls to adjust the playback duration
	Moving an object along a predefined path
	Creating a camera flyby from a path
	Saving an animation in a scene document

	Exercise 6: ArcGlobe basics
	Examining the default layers in ArcGlobe
	Adding more layers
	Changing a layer's drawing priority in the table of contents
	Navigating in Globe mode
	Turning on the Spin toolbar
	Using the Spin tools
	Finding places on the globe
	Navigating in Surface mode
	Setting preferences
	Setting a document-level option

	Exercise 7: ArcGlobe layer classification
	Adding elevation layers
	Adding draped layers
	Setting a target to initiate Surface mode
	Adding floating layers
	Setting elevation properties of floating layers
	Setting a vertical exaggeration factor for floating layers

	Exercise 8: Creating and using a terrain dataset
	Loading surface feature data into a geodatabase
	Building a terrain dataset from features
	Defining the pyramid for the terrain dataset
	Viewing a terrain in ArcMap
	Using the interactive surface analysis tools in ArcMap
	Rasterize a terrain using a geoprocessing tool
	Generate a hillshade using a geoprocessing tool
	Using a terrain as an elevation layer in ArcGlobe
	Optimizing display settings in ArcGlobe

	Exercise 9: Creating a realistic 3D view
	Opening the London Globe document
	Setting the visible distance range of a layer
	Tips on allocating memory cache
	Adding feature data
	Extruding buildings
	Symbolizing features
	Matching symbols in a style
	Using the graphic tools
	Creating a graphic layer
	Setting the target layer and digitizing a 3D point graphic
	Digitizing text graphics
	Adding and modifying a 3D graphics layer
	Final view
	Balance the memory cache for final view


